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Notice of Disclaimer
The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products.To the maximum 
extent permitted by applicable law:(1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES 
AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, 
NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including 
negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, 
the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage 
(including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such 
damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same.Xilinx assumes no obligation to correct 
any errors contained in the Materials or to notify you of updates to the Materials or to product specifications.You may not reproduce, modify, 
distribute, or publicly display the Materials without prior written consent.Certain products are subject to the terms and conditions of the 
Limited Warranties which can be viewed at http://www.xilinx.com/warranty.htm; IP cores may be subject to warranty and support terms 
contained in a license issued to you by Xilinx.Xilinx products are not designed or intended to be fail-safe or for use in any application 
requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in Critical 
Applications:http://www.xilinx.com/warranty.htm#critapps.
© Copyright 2007 - 2013 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated brands 
included herein are trademarks of Xilinx in the United States and other countries.All other trademarks are the property of their respective 
owners.

本資料は英語版 (v14.6) を翻訳したもので、 内容に相違が生じる場合には原文を優先します。
資料によっては英語版の更新に対応していないものがあ り ます。
日本語版は参考用と してご使用の上、 最新情報につきましては、 必ず最新英語版をご参照ください。

この資料に関するフ ィードバッ クおよびリ ンクなどの問題につきましては、 jpn_trans_feedback@xilinx.com までお知らせくだ
さい。 いただきましたご意見を参考に早急に対応させていただきます。 なお、 このメール アドレスへのお問い合わせは受け
付けており ません。 あらかじめご了承ください。

改訂履歴
次の表に、 この文書の改訂履歴を示します。
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2012 年 5 月 28 日 14.1 14.1 アップデート  バージ ョ ン。
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• System Debugger (TCF) および GDB を用いたデバッグに関連する記述をガイ ド全体で
アップデート。

• その他に、 2、 3、 4、 および 5 章で若干の変更。

日付 バージ ョ ン 内容

http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 4
UG873 (v14.6) 2013 年 6 月 19 日

目次

第 1 章 : はじめに
このガイ ドについて  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

チュート リ アル . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
その他の資料 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
ト レーニング演習 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Zynq AP SoC および EDK でエンベデッ ド  プロセッサ デザインを簡略化. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
ISE Design Suite : Embedded Edition  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
エンベデッ ド開発キッ ト . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

ISE ツールでデザイン プロセスを加速  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

最初に必要なセッ ト アップ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
インス トール要件 : EDK ツールの実行条件 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
ハードウェア要件 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

第 2 章 : Zynq プロセッシング システムを使用するエンベデッ ド  システム デザイン
エンベデッ ド  システムの構築 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

チュート リ アル : Zynq プロセッシング システムの新規エンベデッ ド  プロジェク ト を作成する  . . . . . . . . . . 10
チュート リ アル : SDK へエクスポートする . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
チュート リ アル : Hello World アプリ ケーシ ョ ンを実行する . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
その他の情報 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

第 3 章 : Zynq プロセッシング システムおよびプログラマブル ロジックを使用する
エンベデッ ド  システム デザイン
ファブリ ッ クでの Zynq PS への IP 追加 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

チュート リ アル : ファブリ ッ クでインスタンシエート される  IP の機能を確認する  . . . . . . . . . . . . . . . . . . . . . 22
チュート リ アル : SDK を使用する . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

デザイン用のスタンドアロン アプリ ケーシ ョ ン ソフ ト ウェア  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29
アプリ ケーシ ョ ン ソフ ト ウェアの構成手順  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
アプリ ケーシ ョ ン ソフ ト ウェアのコード  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

第 4 章 : SDK および ChipScope を使用したデバッグ
チュート リ アル : SDK を使用してソフ ト ウェアをデバッグする  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

チュート リ アル : ChipScope ツールを使用してハード ウェアをデバッグする . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

第 5 章 : SDK を使用した Linux のブートおよびアプリケーシ ョ ンのデバッグ
必要な環境  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Zynq ボード上で Linux をブートする . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
ブート方法 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
JTAG から  Linux をブートする . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
チュート リ アル : JTAG モードで Linux をブートする . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
チュート リ アル : SDK リモート  デバッグを使用して Linux アプリ ケーシ ョ ンをデバッグする  . . . . . . . . . . . 42
チュート リ アル : QSPI フラ ッシュから  Linux をブートする . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
チュート リ アル : SD カードから  Linux をブートする  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 5
UG873 (v14.6) 2013 年 6 月 19 日

第 6 章 : プロセッシング システムの高性能スレーブ ポート を使用したシステム デザイン
AXI CDMA を Zynq PS の HP スレーブ ポート と統合する . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

チュート リ アル : AXI CDMA を PS の HP スレーブ ポート と統合する  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

デザイン用のスタンドアロン アプリ ケーシ ョ ン ソフ ト ウェア  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
アプリ ケーシ ョ ン ソフ ト ウェアのフロー  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
チュート リ アル : SDK を使用してスタンドアロンの CDMA アプリ ケーシ ョ ンを実行する . . . . . . . . . . . . . . . 58

CDMA システム向けの Linux OS ベースのアプリ ケーシ ョ ン ソフ ト ウェア . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59
アプリ ケーシ ョ ン ソフ ト ウェアの構成手順  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

チュート リ アル : SDK を使用して Linux CDMA アプリ ケーシ ョ ンを実行する  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60
ターゲッ ト  ボートで Linux をブートする  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
SDK を使用し、 アプリ ケーシ ョ ンを構築してそれをターゲッ ト  ボードで実行する . . . . . . . . . . . . . . . . . . . . . 60

第 7 章 : SDK を使用したソフ トウェア プロファイル
SDK を使用したアプリ ケーシ ョ ンのプロファ イル . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

チュート リ アル : SDK でアプリ ケーシ ョ ン ソフ ト ウェアをプロファ イルする  . . . . . . . . . . . . . . . . . . . . . . . . . 63
チュート リ アル : アプリ ケーシ ョ ンにプロファ イル オプシ ョ ンを適用する . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

第 8 章 : アクセラレータ  コヒーレンシ ポート  (ACP)
はじめに  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68

ACP の要求 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
コ ヒーレン ト な ACP 読み出し要求 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
非コ ヒーレン ト な ACP 読み出し要求 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
コ ヒーレン ト な ACP 書き込み要求 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
非コ ヒーレン ト な ACP 書き込み要求 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

ACP の制約 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70

第 9 章 : Linux OS に対応する独自の IP および
デバイス ド ライバーを作成する
必要な環境  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71

ペリ フェラル IP の作成 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  72
 チュート リ アル : ペリ フェラル IP の作成 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

PS の GP マスター ポート を用いてペリ フェラル IP を統合する . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73
チュート リ アル : PS の GP マスター ポート を用いてペリ フェラル IP を統合する . . . . . . . . . . . . . . . . . . . . . . . 74

ペリ フェラル IP 向け Linux ベースのデバイス  
ド ラ イバーの開発 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76
チュート リ アル : デバイス  ド ラ イバーを開発する . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

実行中のカーネルへのモジュールのロード
およびアプリ ケーシ ョ ンの実行 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  77
モジュールをカーネル メモ リへロードする  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
アプリ ケーシ ョ ン ソフ ト ウェア  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
 チュート リ アル : モジュールをカーネルへロード し、 アプリ ケーシ ョ ンを実行する . . . . . . . . . . . . . . . . . . . . 78

付録 A : その他のリソース
このガイ ドのリ ソース  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81

ト レーニング演習  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81

ザイ リ ンクス  リ ソース . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81

EDK の資料 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

EDK 関連のその他のリ ソース . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 6
UG873 (v14.6) 2013 年 6 月 19 日

第 1 章

はじめに

1.1 このガイドについて
このガイ ドでは、Zynq®-7000 All Programmable SoC を使用するザイ リ ンクス  ISE® Design Suite フローについて説明し
ます。 こ こに挙げるサンプル プロジェク トは、 ザイ リ ンクスの ZC702 Rev 1.0 評価ボードおよびツール バージ ョ ン
14.6 をターゲッ ト と しています。

注記 : テス ト  ド ラ イブ (以降 「チュート リ アル」 ) は、 64 ビッ トの Windows 7 オペレーティング システムで作成され
ています。 ほかのバージ ョ ンの Windows では結果が異なる場合があ り ます。

注記 : 第 5、 6、 9 章の 「チュート リ アル」 に記載されているハード ウェアでの Linux のブート  シーケンスは、 14.5 向
けにリ リースされた Linux カーネルに特定されています。

このガイ ドは、 次の章から構成されています。

• 第 1 章では概要を説明します。

• 第 2 章 「Zynq プロセッシング システムを使用する  エンベデッ ド  システム デザイン」 では、 Zynq プロセッシン
グ システム (PS) を用いたシステムの作成、および簡単な Hello World アプリ ケーシ ョ ンの実行について説明しま
す。

• 第 3 章 「Zynq プロセッシング システムおよび プログラマブル ロジッ クを使用する  エンベデッ ド  システム デザ
イン」 では、 Zynq のプロセッシング システム (PS) とプログラマブル ロジッ ク  (PL、 つま り ファブ リ ッ ク ) を使
用してシステムを作成する方法に加え、PS および PL を実行する簡単なアプリ ケーシ ョ ンの使用方法について説
明します。

• 第 4 章 「SDK および ChipScope を使用したデバッグ」 では、 ソフ ト ウェア (SDK デバッグを使用) およびハード
ウェア (ChipScope™ ツールを使用) の観点からデバッグ情報を提供します。

• 第 5 章 「SDK を使用した Linux のブートおよび アプリ ケーシ ョ ンのデバッグ」 では、 Zynq™-7000 AP SoC ボー
ドにおける  Linux OS のブート、 およびアプリ ケーシ ョ ンのデバッグについて情報を提供します。

• 第 6 章 「プロセッシング システムの高性能スレーブ ポート を使用したシステム デザイン」 では、 ファブ リ ッ ク
で AXI CDMA IP をインスタンシエートする際の情報を提供し、 この IP を PS の高性能 (HP) 64 ビッ ト  スレーブ
ポート と結合させる方法について説明します。

• 第 7 章 「SDK を使用したソフ ト ウェア プロファイル」 では、 スタンドアロン BSP のプロファイル機能、 および
第 6 章で作成した AXI CDMA 関連のアプリ ケーシ ョ ンについて説明します。

• 第 8 章 「アクセラレータ  コ ヒーレンシ ポート  (ACP)」 では、 ACP コ ヒーレン トおよび ACP 非コ ヒーレン トの場
合の読み出し要求と書き込み要求に関する情報を提供します。

• 第 9 章「Linux OS に対応する独自の IP および デバイス  ド ラ イバーを作成する」では、Create and Import Peripheral
(CIP) ウ ィザードを使用して IP を作成する方法について説明します。また、ザイ リ ンクス  Zynq™-7000 AP SoC デ
バイス用に作成した IP を使用してシステムを設計します。

• 付録 A 「その他のリ ソース」 では、 このガイ ドに関連するその他の資料へのリ ンクを提供します。
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Zynq AP SoC および EDK でエンベデッ ド  プロセッサ デザインを簡略化

1.1.1 チュート リアル

ソフ ト ウェア ツールの使用方法を習得する最善の方法は、 まず使用してみるこ とです。 このガイ ドでは、実際にツー
ルを操作する機会を提供します。 「チュート リ アル」 では、 サンプル プロジェク トの仕様のほかに背景で何が起こっ
ているかについても説明しています。

チュート リ アルは、 上記のよ うにタイ トルの横にあるクルマのアイコンで示します。

1.1.2 その他の資料

その他の資料一覧は、 付録 A 「その他のリ ソース」 に記載されています。

1.1.3 ト レーニング演習

チュート リ アルの中には関連するタスクをさ らに実践するための ト レーニング演習が利用できるものがあ り ます。演
習がある場合は、 「チュート リ アル」 の 「関連する ト レーニング演習」 にその説明を記載しています。

ト レーニング演習情報へのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。

1.2 Zynq AP SoC および EDK でエンベデッ ド  プロセッ
サ デザインを簡略化
エンベデッ ド  システムは複雑です。 エンベデッ ド  デザインのハード ウェアと ソフ ト ウェアに該当する部分はそれぞ
れがプロジェク ト とな り ます。 2 つのデザイン コンポーネン ト を 1 つのシステムと して機能するよ うに統合するに
は、 さ らに課題が伴います。 その統合されたものに FPGA デザイン プロジェク ト を追加する と、 状況は非常に複雑
になる と考えられます。

Zynq All Programmable SoC ソ リ ューシ ョ ンでは、 ハード  IP と して ARM Cortex A9 デュアル コアが提供されているの
に加えて 1 つの SoC 上でこのコアと共にプログラマブル ロジッ クを使用できるため、 複雑性が緩和されます。

設計プロセスを単純にするために、ザイ リ ンクスからツールが提供されています。基本的なツールおよびプロジェク
ト  ファ イルの名前、 これらツールの略称を把握しておく こ とを推奨します。 EDK 固有の用語は、 次のザイ リ ンクス
用語集に記載されています。 http://japan.xilinx.com/support/documentation/sw_manuals/glossary.pdf

エンベデッ ド開発キッ ト  (EDK) は、 Xilinx Platform Studio (XPS) と ソフ ト ウェア開発キッ ト  (SDK) が組み合わされた
ものです。 ハード ウェアと ソフ ト ウェアのアプリ ケーシ ョ ンの設計、 デバッグ、 実行が可能になるほか、 検証や評価
を目的と してデザインを実際のボードで動作させるのにも役立ちます。

http://japan.xilinx.com/support/documentation/sw_manuals/glossary.pdf
http://japan.xilinx.com
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ISE ツールでデザイン プロセスを加速

1.2.1 ISE Design Suite : Embedded Edition
ザイ リ ンクスは、 ISE Design Suite と総称される開発システム ツールを複数提供しています。 エンベデッ ド  システム
開発向けに提供されているのが ISE Design Suite : Embedded Edition です。 Embedded Edition は次のツールで構成され
ています。

• ISE (Integrated Software Environment)

• PlanAhead™ デザイン解析ツール

• FPGA デザインのオンチップ デバッグに有用な ChipScope Pro

• エンベデッ ド開発キッ ト  (EDK) 

EDK は DSP デザイン向けの ISE Design Suite : System Edition にも含まれます。

FPGA デザインに ISE ツールを使用する方法の詳細は、付録 A 「その他のリ ソース」 に記載されている資料を参照し
てください。

1.2.2 エンベデッ ド開発キッ ト

EDK はザイ リ ンクスの FPGA デバイスに実装する完全なエンベデッ ド  プロセッサ システムを設計する際に使用可能
なツール セッ トおよび IP コアです。

Xilinx Platform Studio

Xilinx Platform Studio (XPS) はエンベデッ ド  プロセッサ システムのハード ウェア部分の設計に使用する開発環境で
す。 XPS はバッチ モードまたは GUI を使用して実行できます。 このガイ ドにはその実行例が示されています。

ソフ トウェア開発キッ ト

ソフ ト ウェア開発キッ ト  (SDK) は XPS を補完する統合開発環境で、 C/C++ エンベデッ ド  ソフ ト ウェア アプ リ ケー
シ ョ ンの作成および検証に使用します。 SDK は Eclipse オープンソース  フレームワークで構築されているため、 ソフ
ト ウェア設計者や設計チームにとって使い慣れた環境です。 Eclipse 開発環境の詳細は、 http://www.eclipse.org を参照
してください。

その他の EDK コンポーネン ト

EDK のその他のコンポーネン トは次のとおりです。 

• ザイ リ ンクス  エンベデッ ド  プロセッサ用のエンベデッ ド /ソフ ト  IP

• エンベデッ ド  ソフ ト ウェア開発用のド ライバーおよびライブラ リ

• Zynq プロセッシング システムの ARM Cortex-A9MP プロセッサをターゲッ トにした C/C++ ソフ ト ウェア開発向
け GNU コンパイラおよびデバッガー

• 資料

• サンプル プロジェク ト

1.3 ISE ツールでデザイン  プロセスを加速
PlanAhead デザイン解析ツールではデザイン ソースをハード ウェアに追加できます。 このハード ウェア システムは
XPS を用いて作成可能です。 XPS を使用するこ とで、 必要な IP を簡単に既存のデザイン ソースへ追加してクロ ッ ク
やリセッ ト などのポート接続を作成できます。

http://www.eclipse.org
http://japan.xilinx.com
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最初に必要なセッ トアップ

• XPS は主に、 エンベデッ ド  プロセッサ システムの開発に使用します。 XPS では、 マイ クロプロセッサおよびペ
リ フェラルの仕様、 これらのコンポーネン トの接続およびプロパティを設定します。

• ソフ ト ウェア開発には SDK を使用します。SDK はスタンドアロンのアプリ ケーシ ョ ンと して提供されています。
このツールは、購入後、 ロード先のマシンにほかのザイ リ ンクスのツールがインス トールされていなくても使用
可能です。 また、 ソフ ト ウェア アプリ ケーシ ョ ンのデバッグに使用できます。

Zynq プロセッシング システム (PS) は、FPGA プログラマブル ロジッ ク  (PL) に何もプログラムされていなくてもブー
ト して動作させるこ とができます。 ただし、 ファブ リ ッ クでソフ ト  IP を使用したり、 EMIO を用いて PS ペリ フェラ
ルを接続するには、 PL をプログラムする必要があ り ます。 この手順は SDK から実行できます。

XPS に関するエンベデッ ド  デザイン プロセスの詳細は、 『エンベデッ ド  システム ツール リ ファレンス  マニュアル』
の 「デザイン プロセスの概要」 を参照して ください。 この資料へのリ ンクは、 付録 A 「その他のリ ソース」 に記載
されています。

注記 : Zynq 開発ツールの初期バージ ョ ンでは、 プロセッシング システムは直接シ ミ ュレーシ ョ ンできません。

1.4 最初に必要なセッ トアップ
ツールについて詳し く説明する前に、 ツールが適切にインス トールされ、 セッ ト ア ップした環境がこのガイ ドの
「チュート リ アル」 の記載要件に一致するかを確認します。

1.4.1 インストール要件 : EDK ツールの実行条件

PlanAhead ツールおよび EDK

PlanAhead デザイン ツールおよび EDK はいずれも  ISE Design Suite : Embedded Edition に含まれています。ソフ ト ウェ
アと最新アップデートがインス トールされているこ とを確認してください。ソフ ト ウェア バージ ョ ンが最新であるか
ど うかは、 http://japan.xilinx.com/support にアクセスして確認できます。

ソフ トウェアのライセンス

ザイ リ ンクスのソフ ト ウェアには FLEXnet ライセンスが使用されています。 ソフ ト ウェアを初めて起動する際、 ライ
センスの検証プロセスが実行されます。有効なライセンスが検出されない場合、ライセンス  ウ ィザードに従ってライ
センスを取得し、ザイ リ ンクス  ツールがそのライセンスを使用できるよ うにします。ソフ ト ウェアの評価のみが目的
であれば、 評価ライセンスを取得できます。

ザイ リ ンクス  ソフ ト ウェアのライセンスの詳細は、 『ISE Design Suite 14 : リ リース  ノート 、 インス トール、 ライセン
ス  ガイ ド』 (UG631) を参照してください。 この資料へのリ ンクは、付録 A 「その他のリ ソース」 に記載されています。

1.4.2 ハードウェア要件

このガイ ドでは、 Zynq ZC702 Rev 1.0 評価ボードをターゲッ ト と しています。 このガイ ドを活用するにあたって、 評
価ボードに同梱されている次を用意してください。

• ZC702 評価ボード

• AC 電源アダプター (12 VDC)

• USB Type-A/Mini-B ケーブル (UART 通信用)

• JTAG を介するプログラムおよびデバッグ用の Digilent 社製ケーブル

• Linux ブート用の SD-MMC フラ ッシュ  カード

• ターゲッ ト  ボード とホス ト  マシンの接続用のイーサネッ ト  ケーブル

http://japan.xilinx.com/support
http://japan.xilinx.com
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第 2 章

Zynq プロセッシング システムを使用する
エンベデッ ド  システム デザイン

ザイ リ ンクスのエンベデッ ド開発キッ ト  (EDK) の概要に引き続き、 このツールを活用して Zynq®-7000 AP SoC プロ
セッシング システムを使用するエンベデッ ド  システムを開発する方法を説明します。

Zynq AP SoC は、 ARM Cortex A9 ハード  IP とプログラマブル ロジッ クで構成されています。 これらは次の 2 つの方
法で使用できます。

1. Zynq PS は、 ファブリ ッ クからの追加 IP なしでスタンドアロン モードで使用できます。

2. IP は、ファブリ ッ クでインスタンシエート して Zynq PS で使用可能です。PS と  PL を組み合わせて使用するこ と
で、 1 つの SoC で複雑かつ高効率なデザインを実現できます。

2.1 エンベデッ ド  システムの構築
Zynq システム デザインの作成には、 ブート  デバイスおよびペリ フェラルを適切に選択する  PS のコンフ ィギュレー
シ ョ ンが含まれます。 PS ペリ フェ ラルと利用可能な MIO の接続がデザイン要件を満たしている限り、 ビ ッ ト ス ト
リームは必要あ り ません。 この章では、 このよ うなデザインの作成方法を説明します。

2.1.1 チュート リアル : Zynq プロセッシング システムの
新規エンベデッ ド  プロジェク ト を作成する

このチュート リ アルでは、 ISE® の PlanAhead™ デザイン解析ツールを起動し、 エンベデッ ド  プロセッサ システムの
プロジェク ト を最上位と して作成します。

PlanAhead デザイン  ツールでデザインを開始する

1. PlanAhead ツールを起動します。

2. [Create New Project] をク リ ッ ク して New Project ウ ィザードを開きます。

3. 次の表の情報に基づいて、 ウ ィザード画面で選択操作を行います。

ウィザード画面 システム プロパティ 設定または使用するコマンド

Project Name Project Name プロジェク ト名を指定する。

Project Location プロジェク ト  ファ イルを格納するディ レク ト リ を
指定する。

Create Project Subdirectory チェッ ク  ボッ クスをオンのままにする。

Project Type デザインのソースのタイプを指
定する。 RTL または合成済み
EDIF から開始できる。

デフォルトの [RTL Project] を使用する。

http://japan.xilinx.com
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エンベデッ ド  システムの構築

[Finish] をク リ ッ クする と  New Project ウ ィザードが閉じ、作成したプロジェク トが PlanAhead デザイン ツールで開き
ます。

こ こからは Add Sources ウ ィザードを使用し、 エンベデッ ド  プロセッサ プロジェク ト を作成します。

1. [Project Manager] で [Add Sources] をク リ ッ ク します。

Add Sources ウ ィザードが表示されます。

2. [Add or Create Embedded Sources] をオンにし、 [Next] をク リ ッ ク します。

3. [Add or Create Embedded Source] ウ ィンド ウで [Create Sub-Design] をク リ ッ ク します。

4. モジュール名を入力して [OK] をク リ ッ ク します。 この例では、 「system」 とい う名前を入力します。

作成したモジュールがソース  リ ス トに表示されます。

5. [Finish] をク リ ッ ク します。

PlanAhead デザイン ツールでエンベデッ ド  デザイン ソース  プロジェク トが作成されます。 このツールは、 エン
ベデッ ド  プロセッサ システムの存在を認識し、 XPS を起動します。

XPS でデザインを継続する

XPS では、 次の 2 つの方法で新しいエンベデッ ド  システムを設計できます。

• Base System Builder (BSB) ウ ィザードを使用する

BSB ウ ィザードでは、 プロセッシング システムの I/O インターフェイスを選択してコンフ ィギュレーシ ョ ンし、
デフォル トのペリ フェラルをファブ リ ッ クに追加できます。 ザイ リ ンクスは、 常に BSB ウ ィザードを使用して
新しいエンベデッ ド  デザイン プロジェク トの基礎を作成するこ とを推奨します。

• 空のプロジェク ト を作成する

このオプシ ョ ンでは、 プロセッシング システムを手動でデザインへ追加し、 I/O インターフェイスをコンフ ィ
ギュレーシ ョ ンする必要があ り ます。

BSB ウィザードを使用して新しいエンベデッ ド  システムを設計する

1. BSB ウ ィザードを使用してベース  システムを作成するかど うかを確認するダイアログ ボッ クスが表示された
ら、 [Yes] をク リ ッ ク します。

BSB の最初のウ ィンド ウでは、 システムを AXI ベースまたは PLB ベースにするかの選択が求められます。

2. AXI システムを選択して [OK] をク リ ッ ク します。

Add Sources この画面では変更しない。

Add Existing IP この画面では変更しない。

Add Constraints この画面では変更しない。

Default Part Specify [Boards] を選択する。

Board [Zynq-7 ZC702 Evaluation Board] を選択する。

New Project Summary Project Summary [Finish] をク リ ッ クする前にプロジェ ク ト  サマ リ
を再確認し、 プロジェク ト を作成する。

ウィザード画面 システム プロパティ 設定または使用するコマンド

http://japan.xilinx.com
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エンベデッ ド  システムの構築

3. Base System Builder ウ ィザードで、 次の表に記載されている設定を使用してプロジェク ト を作成します。 設定ま
たはコマンドが表に記載されていない場合は、 デフォルトの値に従います。

4. デザインを生成するには、 [Finish] をク リ ッ ク します。

5. XPS ウ ィンド ウを閉じます。アクティブな PlanAhead ツール セッシ ョ ンが、プロジェク トの設定でアップデート
されます。

ソフ ト ウェア開発用にシステム情報を SDK にエクスポートする方法は、 「2.1.2 チュート リ アル : SDK へエクス
ポートする」 を参照してください。

空のプロジェク ト を使用して新しいエンベデッ ド  システムを設計する

BSB ウ ィ ザー ド でデフ ォル ト のエンベデッ ド  システムを作成済みの場合は、 このセ ク シ ョ ンを省略し て
「2.1.2 チュート リ アル : SDK へエクスポートする」 へ進んでください。

1. BSB ウ ィザードを使用してベース  システムを作成するかど うかを確認するダイアログ ボッ クスが表示された
ら、 [No] をク リ ッ ク します。

こ こでは、 プロセッサをシステムに手動で追加します。

2. IP カタログで [Processor] → [Processing System] をク リ ッ ク し、 プロセッサをシステムに追加します。

processing_system7 4.03.a インスタンスを 1 つデザインに追加するかど うかを確認するダイアログ ボッ クスが表
示されます。

3. [Yes] をク リ ッ ク してプロセッサ インスタンスを追加します。

4. [Bus Interfaces] タブをク リ ッ ク します。 processing_system7 が追加されているこ とを確認します。

ウィザード画面 システム プロパティ 使用する設定コマンド

Board and System
Selection

Board デフォルトのオプシ ョ ンを使用し、 Zynq ZC702 評価プラ ッ ト フォーム
リ ビジ ョ ン C 向けのシステムを作成する。

注記 : こ こでは、 PlanAhead ツールで選択したボードが自動入力される。

Board Configuration ボードの選択に基づいて情報が自動入力される。

Select a System Zynq プロセッシング システム 7

Peripheral
Configuration

Select and Configure
Peripherals

[Included Peripherals] リ ス トから次を削除する。
• GPIO_SW
• LEDs_4Bits

http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 13
UG873 (v14.6) 2013 年 6 月 19 日

エンベデッ ド  システムの構築

5. [System Assembly] ビューで [Zynq] タブをク リ ッ ク し、 Zynq プロセッシング システムのブロッ ク図を開きます。

ブロ ッ ク図の構成を確認します。 Zynq プロセッシング システム ブロ ッ ク図の緑色のブロ ッ クは、 コンフ ィギュ
レーシ ョ ン可能です。ブロ ッ クをク リ ッ クする と、それと関連するコンフ ィギュレーシ ョ ン ウ ィンド ウが開きま
す。

X-Ref Target - Figure 2-1

図 2-1 : XPS の [System Assembly] ビュー

X-Ref Target - Figure 2-2

図 2-2 : Zynq プロセッシング システム
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6. [Import Zynq Configurations]  をク リ ッ ク します。

[Import Zynq Configurations] ダイアログ ボッ クスが開きます。

7. ZC702 ボード用のコンフ ィギュレーシ ョ ン テンプレート  ファ イルを選択します。 デフォルトで選択されるテン
プレートは、 ローカル マシンの ZC702 ボードに対応するインス トール パスにあるものです。

8. [OK] をク リ ッ ク します。

9. Zynq MIO コンフ ィギュレーシ ョ ンとデザインがアップデート されるこ とを確認するウ ィンド ウが開いたら、
[Yes] をク リ ッ ク します。 

X-Ref Target - Figure 2-3

図 2-3 : [Import Zynq Processing System Configurations] ダイアログ ボックス
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10. Zynq のブロ ッ ク図が変更されているこ とを確認します。 I/O ペリ フェラルがアクティブになり ます。

11. ブロ ッ ク図で緑色の I/O Peripherals ボッ クスをク リ ッ ク します。

ZC702 のボード  レイアウ トに従っていくつかの MIO ピンが複数のペリ フェラルに割り当てられており、 これら
のペリ フェラルはプロセッシング システムで有効となっています。 たとえば、 UART1 は有効で、 UART0 は無効
です。 これは、 UART1 が UART を経由して USB - UART コネク タを介し、 ZC702 ボードの USB コンバーター
チップへ接続されているためです。

12. [Zynq PS MIO Configurations] ダイアログ ボッ クスを閉じます。

13. XPS ウ ィンド ウを閉じます。アクティブな PlanAhead ツール セッシ ョ ンが、プロジェク トの設定でアップデート
されます。

ソフ ト ウェア開発用にシステム情報を SDK にエクスポートする方法は、 「2.1.2 チュート リ アル : SDK へエクス
ポートする」 を参照してください。

2.1.2 チュート リアル : SDK へエクスポートする

このデモの活用では、 PlanAhead ツールから  SDK を起動します。

1. [Sources] ペインの [Design Sources] で、 [system(system.xmp)] を右ク リ ッ ク して [Create Top HDL] をク リ ッ ク しま
す。

PlanAhead がデザインの最上位モジュールである  system_stub.v を生成します。

2. PlanAhead ツールで、 [File] → [Export] → [Export Hardware for SDK] をク リ ッ ク します。

[Export Hardware] ダイアログ ボッ クスが開きます。 デフォルトでは、 [Export Hardware] がオンになっています。

3. [Launch SDK] をオンにします。

X-Ref Target - Figure 2-4

図 2-4 : アップデート後の Zynq のブロック図
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4. [OK] をク リ ッ クする と、 SDK が開きます。

SDK が起動する と、 ハード ウェア記述ファイルが自動的に読み込まれます。 [system.xml] タブは、 プロセッシング シ
ステム全体のアドレス  マップを表示します。

5. SDK を閉じます。

ここまでの結果

PlanAhead デザイン ツールによって、 デザインのハード ウェア プラ ッ ト フォーム仕様 (この例では system.xml) が
SDK にエ ク スポー ト されま し た。 system.xml に加え、 さ らにフ ァ イル (ps7_init.c、 ps7_init.h、
ps7_init.tcl、 ps7_init.html) が SDK にエクスポート されています。

SDK が起動する と、 system.xml ファ イルがデフォルトで開きます。 このファイルから読み出されるシステムのアドレ
ス  マップがデフォルトで SDK ウ ィンド ウに表示されます。

ps7_init.c および ps7_init.h ファ イルには、Zynq プロセッシング システムの初期化コードのほかに、DDR、 ク
ロ ッ ク、 PLL、 および MIO の初期化設定が含まれます。 SDK は、 アプ リ ケーシ ョ ンがプロセッシング システムの最
上位で実行可能となるよ うに、 これらの設定をプロセッシング システムの初期化時に使用します。 プロセッシング
システムの設定の中には ZC702 評価ボード向けに固定されているものがあ り ます。

次に実行すること

これで、 SDK を使用してプロジェク トのソフ ト ウェア開発を開始できます。 次のセクシ ョ ンでは、 ハード ウェア プ
ラ ッ ト フォーム向けのソフ ト ウェア アプリ ケーシ ョ ンの作成に役立つ情報を提供します。

X-Ref Target - Figure 2-5

図 2-5 : SDK の [system.xml] タブのアドレス マップ
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2.1.3 チュート リアル : Hello World アプリケーシ ョ ンを実
行する

1. 電源ケーブルをボードに接続します。

2. Digilent 社製ケーブルを使用して Windows ホス ト  マシンと、 SW10 スイ ッチを次のよ うに設定したターゲッ ト
ボードを接続します。 

° ビッ ト  1 : 0

° ビッ ト  2 : 1

注記 : 0 = 開スイ ッチ1 = 閉スイ ッチ

3. USB ケーブルを Windows ホス ト  マシンと ターゲッ ト  ボードのコネクタ  J17 につなぎます。シ リ アル転送に USB
を使用する際はこのよ うに接続します。

4. 図 2-6 に示すスイ ッチを使用して ZC702 ボードに電源を投入します。

重要 : ジャンパー J27 および J28 は SD カード  スロ ッ トから離れた側に設定し、SW16 スイ ッチを図 2-6 に示すとおり
に設定します。

5. SDK を開いてワークスペース  パスを <project dir>/project_1/project_1.sdk/SDK/
SDK_Export に設定します。

6. [Xilinx Tools] → [Configure JTAG Setting] をク リ ッ ク します。

Configure JTAG Settings ウ ィザードが開きます。

X-Ref Target - Figure 2-6

図 2-6 : ZC702 ボードの電源スイッチ
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7. ウ ィザードでは、 [JTAG Cable] の下にある  [Type] が [Xilinx Auto Detect] に設定されているこ とを確認します。 

8. [OK] をク リ ッ ク します。

9. システムで割り当てられている  COM ポートのシ リ アル通信ユーティ リ ティ を開きます。SDK ではシ リ アル ター
ミナル ユーティ リ ティが提供されています。[Window] → [Show View] → [Terminal] をク リ ッ ク してこのユーティ
リ ティ を開きます。

注記 : Zynq プロセッシング システムの標準的な設定は、 「ボー レート  115200、 8 ビッ ト 、 パリ ティ  : なし、 停止
: 1 ビッ ト 、 フロー制御 : なし」 です

10. [File] → [New] → [Application Project] をク リ ッ ク します。

New Project ウ ィザードが開きます。

11. 次の表の情報に基づいて、 ウ ィザード画面で選択操作を行います。

SDK によって hello_world アプ リ ケーシ ョ ン プロジェ ク トおよび  hello world_bsp BSP プロジェ ク ト が [Project
Explorer] の下に作成されます。 これらの両プロジェク トは自動的にコンパイルされ、ELF ファ イルが作成されま
す。

12. [hello_world] を右ク リ ッ ク して [Run as] → [Run Configurations] をク リ ッ ク します。

13. [Xilinx C/C++ application (GDB)] を右ク リ ッ ク して [New] をク リ ッ ク します。

SDK によって hello_world Debug という名前の新しい実行コンフ ィギュレーシ ョ ンが作成されます。

アプ リ ケーシ ョ ンに関連するコンフ ィギュレーシ ョ ンは、起動コンフ ィギュレーシ ョ ンの [Main] タブに自動入力
されます。

14. 起動コンフ ィギュレーシ ョ ンの [Device Initialization] タブをク リ ッ ク し、 設定を確認します。

初期化 TCL フ ァ イルへのコ ンフ ィ ギ ュ レーシ ョ ン パスがあ る こ と に着目し て く だ さい。 こ こ では
ps7_init.tcl へのパスです。 このファイルは、 デザインを  SDK にエクスポート した際にエクスポート された
もので、 プロセッシング システムの初期化情報を含みます。

15. [STDIO Connection] タブは、起動コンフ ィギュレーシ ョ ンの設定で使用できます。 このタブを使用して STDIO を
コンソールに接続させるこ とができます。こ こからは、シ リ アル通信ユーティ リ ティがすでに起動しているため、
このタブを使用するこ とはあ り ません。起動コンフ ィギュレーシ ョ ンにはほかにもオプシ ョ ンがあ り ますが、 こ
れらについては後半で説明します。

16. [Run] をク リ ッ ク します。

17. シ リアル通信ユーティ リ ティに Hello World が表示されます。

注記 : Zynq 評価ボードで実行する上記ソフ ト ウェア アプ リ ケーシ ョ ン用にビッ ト ス ト リームをダウンロードする必
要はあ り ませんでした。ARM Cortex A9 デュアル コアはすでにボードに実装されています。簡単なアプリ ケーシ ョ ン
を実行するこ とを目的と したこのシステムの基本的な初期化は、 デバイス初期化 TCL スク リプ トで実行されます。

ウィザード画面 システム プロパティ 使用する設定コマンド

Application Project

Project Name hello_world

Use Default Location このオプシ ョ ンをオンにする。

Hardware Platform system_hw_platform

Processor PS7_cortexa9_0

OS Platform スタンドアロン

Language C

Board Support Package [Create New] をク リ ッ ク して
「hello_world_bsp」 とい う名前を付ける。

Templates Available Templates Hello World
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ここまでの結果

アプリ ケーシ ョ ン ソフ ト ウェアによって、 Hello World の文字列が PS の UART1 ペリ フェラルに送信されました。

UART1 からホス ト  マシンで動作しているシ リ アル ターミナル アプリ ケーシ ョ ンへ、 Hello World の文字列がバイ ト
ごとに送信され、 文字列と して表示されます。

関連する ト レーニング演習

このチュート リ アルに関連する ト レーニング演習は、 『Zynq®-7000 All Programmable SoC デザイン ワークシ ョ ップ :
ベア メ タル ソフ ト ウェア開発』 です。

この演習では、 次について学習します。

• ハードウェア記述を SDK にインポートする

• BSP を作成およびカスタマイズする

• SDK を使用してソフ ト ウェアをダウンロード、 デバッグ、 および実行する

• 簡単なアプリ ケーシ ョ ンのプロファ イルを実行し、 ソフ ト ウェアで時間がかかっている場所を特定する

• チップのデバッグを実行し、 ChipScope Pro Analyzer を使用して AXI ト ランザクシ ョ ンを確認する

ト レーニング演習情報へのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。

2.1.4 その他の情報

ボード  サポート  パッケージ

ボード  サポート  パッケージ (BSP) はハードウェア プラ ッ ト フォームまたはボードのサポート  コードです。 このコー
ドは、 電源投入時の基本的な初期化に役立つだけでなく、 ソフ ト ウェア アプリ ケーシ ョ ンがハード ウェア プラ ッ ト
フォームまたはボードの最上位で実行されるよ うにサポート します。これは、ブート ローダーおよびデバイス  ド ラ イ
バーを備えるオペレーティング システム固有のものにできます。

スタンドアロンの OS

スタンドアロンはシンプルな下位ソフ ト ウェア層です。 これは、キャッシュ、割り込み、例外などの基本的なプロセッ
サ機能およびホス ト環境の基本的なプロセッサ機能へのアクセスを提供します。これらの機能には、標準の入力/出力、
プロファイル、 停止、 終了が含まれます。 これはセミホス ト型のシングル スレッ ド環境です。

この章で実行したアプリ ケーシ ョ ンが、 スタンドアロン OS の最上位に作成されました。
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第 3 章

Zynq プロセッシング システムおよび
プログラマブル ロジックを使用する
エンベデッ ド  システム デザイン

ザイ リ ンクスの Zynq®-7000 AP SoC をエンベデッ ド  デザインのプラ ッ ト フォームと して使用する場合、 独自の特徴
の 1 つは、 ARM Cortex A9 デュアル コア プロセッシング システムに Zynq のプロセッシング システム (PS) を使用で
きるだけでなく、 プログラマブル ロジッ ク  (PL) も使用できるこ とです。

この章では、 次を備えるデザインを作成します。

• AXI GPIO およびファブリ ッ クから  PS への割り込みを持つ AXI タイマー

• PL でインスタンシエート される  ChipScope™ IP

• EMIO インターフェイスを介して PL 側のピンへ接続される  Zynq PS GPIO ピン

この章のフローは第 2 章で説明した内容と類似しています。 こ こでは、第 2 章の内容について繰り返し言及している
ため、 前章を省略した場合はその内容を確認する必要があ り ます。

3.1 ファブリ ックでの Zynq PS への IP 追加
ファブ リ ッ クで追加可能な Zynq PS と密に結合される  IP は、 どんなに複雑なものでも制限はあ り ません。 こ こでは、
AXI GPIO、 割り込みを持つ AXI タイマー、 EMIO インターフェイスを介して PL 側のピンへ接続される  PS の GPIO
ピン、 そしてコンセプ ト を実証するための ChipScope インスタンシエーシ ョ ンを用いて簡単な例を説明します。

こ こでは、デザインを作成して、 AXI GPIO、 ファブ リ ッ クでインスタンシエート された割り込み付き  AXI タイマー、
および EMIO インターフェイスを持つ PS の GPIO の機能を確認します。図 3-1 にシステムのブロ ッ ク図を示します。
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このシステムは、 次のよ うに接続されています。

• ファブ リ ッ ク側の AXI GPIO は 1 ビッ ト幅のチャネルのみを備え、 ZC702 ボード上のプッシュボタン スイ ッチ
SW5 へ接続されています。

• PS の GPIO も、EMIO インターフェイスを介してファブリ ッ ク  ピンへ配線される  1 ビッ ト幅のインターフェイス
を備えており、 ボード上のプッシュボタン スイ ッチ SW7 へ接続されています。

• PS では、 別の 1 ビッ ト  GPIO が MIO ポートにあるボード上の LED DS23 へ接続されています。

• AXI タイマーの割り込みはファブリ ッ クから  PS の割り込みコン ト ローラーへ接続されます。 このタイマーは、
ボード上の指定されたプッシュ  ボタンを押すと開始します。タイマーが終了する と、その割り込みが ト リガーさ
れます。

アプ リ ケーシ ョ ン ソフ ト ウェアのコードを書き込みます。 コードを実行する際、 シ リ アル ターミナルにメ ッセージ
が表示され、 ボードで使用するプッシュ  ボタン スイ ッチ (SW7 または SW5 のいずれか) の選択が求められます。 その
ボタンを押すと、 タイマーは動作を自動的に開始して LED DS23 をオフにし、 タイマーの割り込みが発生するのを待
機します。 タイマーの割り込みが発生する と、 LED DS23 がオンになり、 タイマーは実行を再開してシ リ アル ターミ
ナルでプッシュ  ボタン スイ ッチが再度選択されるのを待機します。

後半のセクシ ョ ンで AXI モニターを使用したハード ウェアのデバッグ方法について説明するため、 ICON (ChipScope
Integrated Controller) IP および AXI Monitor IP をデザインに追加します。

第 2 章の該当セクシ ョ ンは、 このデザイン フローにも有効です。第 2 章で作成したシステムを使用し、「2.1.1 チュー
ト リ アル : Zynq プロセッシング システムの新規エンベデッ ド  プロジェク ト を作成する」 に従って必要な手順を実行
します。

X-Ref Target - Figure 3-1

図 3-1 : ブロック図
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3.1.1 チュート リアル : ファブリ ックでインスタンシエー
ト される  IP の機能を確認する

このチュート リ アルでは、 AXI GPIO、 ファブ リ ッ クでインスタンシエート される割り込み付き  AXI タイマー、 およ
び EMIO インターフェイスの機能を確認します。

1. PlanAhead™ ツールの [Sources] ペインで、 [system_i-system(system.xmp)] をダブルク リ ッ ク して XPS を
起動します。 これは、 10 ページの 「チュー ト リ アル : Zynq プロセッシング システムの新規エンベデッ ド  プロ
ジェク ト を作成する」 で作成したエンベデッ ド  ソースです。

2. [XPS System Assembly] ビューで [Bus Interfaces] タブをク リ ッ ク します。

3. IP カタログで [General Purpose IO] を展開し、 [AXI General Purpose IO] をダブルク リ ッ ク して追加します。

axi_gpio 1.01.b IP インスタンスをデザインへ追加するかど うかを確認する メ ッセージが表示されます。

4. [Yes] をク リ ッ ク します。

GPIO のコンフ ィギュレーシ ョ ン ウ ィンド ウが開きます。

5. [Channel 1] を展開してチャネル 1 のコンフ ィギュレーシ ョ ン パラ メーターを表示させます。 

6. [GPIO Data Channel Width] の値が 32 となっているこ とを確認します。デザインの動作には 1 ビッ トの入力のみが
必要なため、 この値を 1 に変更します。 ほかのパラ メーターは変更せずにそのままにします。 

7. [OK] をク リ ッ ク します。

「axi_gpio IP with version number 1.01.b is instantiated with name axi_gpio_0」とい う メ ッセージが表示されたメ ッセー
ジ ウ ィンド ウが開きます。接続先のプロセッサを決定するよ うに求められます。 こ こでは、 デュアル コア ARM
プロセッサを使用して設計しています。 また、 このメ ッセージは、 XPS でバス  インターフェイスの接続および
アドレスの割り当てが実行され、 IO ポートが外部に設定されるこ とを示します。

プロセッサのデフォルト選択は processing_system7_0 です。 このままこれを使用します。

8. [OK] をク リ ッ ク します。

一部自動ではなく手動で接続すべきものがあ り ます。

注記 : AXI インターコネク トは、 ファブ リ ッ クの IP および PS のインターコネク ト間で自動的にインスタンシ
エート されます。 この例では、 AXI GPIO が AXI インターコネク ト を介して PS へ接続されます。

9. IP カタログで [DMA and Timer] を展開し、 [AXI Timer/Counter IP] をダブルク リ ッ ク して追加します。

axi_timer_1.03.a IP インスタンスをデザインに追加するかど うかを確認するダイアログ ボッ クスが表示されます。

10. [Yes] をク リ ッ ク します。

TIMER のコンフ ィギュレーシ ョ ン ウ ィンド ウが開きます。ほかのパラ メーターは変更せずにそのままにします。

11. [OK] をク リ ッ ク します。

「axi_timer IP with version number 1.03.a is instantiated with name axi_timer_0.」 と表示されたメ ッセージ ウ ィンド ウ
が開きます。 接続先のプロセッサを決定するよ うに求められます。 こ こでは、 デュアル コア ARM プロセッサを
使用して設計しています。 また、 このメ ッセージは、 XPS でバス  インターフェイスの接続およびアドレスの割
り当てが実行され、 IO ポートが外部に設定されるこ とを示します。

プロセッサのデフォルト選択は processing_system7_0 です。 このままこれを使用します。

12. [OK] をク リ ッ ク します。

このセクシ ョ ンの後半では、 AXI タイマーの割り込みを PS の割り込みに手動で接続します。

13. IP カタログで [Debug] を展開し、 2 つの IP (ChipScope AXI Monitor と  ChipScope Integrated Controller) をデザイン
に追加します。 いずれの IP のコンフ ィギュレーシ ョ ンも変更しません。

14. IP およびそれらのポートがリ ス ト されている  [Ports] タブをク リ ッ ク します。 axi_interconnect_1、
axi_gpio_0、 axi_timer_0、 chipscope_axi_monitor_0、 および chipscope_icon_0 を展開します。
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15. 次の IP の接続を確認します。 これらの中で接続されていないものがあれば、 こ こで接続します。

[Ports] タブの内容が図 3-2 のよ うに設定されます。

16. すべての IP を非展開にし、 [processing_system7_0] を展開します。 次のよ うにポートが接続されていない
場合は、 こ こで接続します。 図 3-3 のよ うに接続します。

表 3-1 : IP 接続

IP ポート 接続

axi_interconnect_1 INTERCONNECT_ACLK processing_system7_0 :FCLK_CLK0

INTERCONNECT_ARESETN processing_system7_0::FCLK_RESET0_N

axi_gpio_0 (BUS_IF) S_AXI::S_AXI_ACLK processing_system7_0 : FCLK_CLK0

(IO_IF) gpio_0::GPIO_IO External Port ::axi_gpio_0_GPIO_IO_pin

axi_timer_0 (BUS_IF) S_AXI_::S_AXI_ACLK processing_system7_0 :FCLK_CLK0

Chipscope_axi_monitor_0 CHIPSCOPE_ICON_CONTROL Chipscope_icon_0 ::control0

(BUS_IF) MON_AXI::MON_AXI_ACLK processing_system7_0 : FCLK_CLK0

Chipscope_icon_0 Control0 Chipscope_axi_monitor0::CHIPSCOPE_
ICON_CONTROL

X-Ref Target - Figure 3-2

図 3-2 : 完成したポート接続

IP ポート 接続

Processing_system7_0 (BUS_IF) M_AXI_GP0::M_AXI_GPO_ACLK processing_system7_0 ::FCLK_CLK0
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17. 次の手順に従って、 ファブ リ ッ ク側のタイマー割り込みを PS 側の割り込みコン ト ローラーへ接続します。

a. [Processing_System7_0] の [Connected Port] 列で [1L to H:No Connection] をク リ ッ ク します。

[Interrupt Connection] ダイアログ ボッ クスが開きます。

b. [Unconnected Interrupts] リ ス トで axi_timer_0 を選択し、 矢印をク リ ッ ク して選択したアイテムを  [Connected
Interrupts] リ ス トへ移動させます。

X-Ref Target - Figure 3-3

図 3-3 : Processing_system7_0 の展開および M_AXI_GP0_ACLK の接続 

X-Ref Target - Figure 3-4

図 3-4 : [Interrupt Connection] ダイアログ ボックス
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図 3-5 に、 割り込み ID 91 に接続される  axi_timer_0 割り込みインスタンスを示します。

c. [OK] をク リ ッ ク します。

XPS でファブリ ッ ク側のタイマー割り込みが PS の割り込みコン ト ローラーへ接続されます。

18. [Bus Interfaces] タブをク リ ッ ク し、 [chipscope_axi_monitor_0] を展開します。 

19. [Bus Name] 列で [No Connection] をク リ ッ ク します。 表示される ド ロ ップダウン リ ス トで chipscope_axi_
monitor を axi_gpio_0.S_AXI に接続します。

このよ う に接続する こ と で、 axi_gpio_0 ス レーブ AXI バス上のあ らゆる  AXI 関連の ト ラ ンザ ク シ ョ ンを
ChipScope Analyzer で監視できます。

20. 次の手順に従って、 EMIO インターフェイスを使用して PS の GPIO を PL 側のパッ ドへ配線します。

a. [XPS System Assembly] ビューで [Zynq] タブをク リ ッ ク します。

b. [I/O Peripherals] をク リ ッ ク して [Zynq PS Configuration] ダイアログ ボッ クスを開きます。 

c. [Zynq PS Configuration] タブで [GPIO] を展開します。

d. [EMIO GPIO (Width)] をオンにします。

[Width of EMIO GPIO] の設定は、 次の列で有効になり ます。 デフォルトの設定は 64 です。

e. EMIO GPIO の幅を 1 に設定し、 [Close] をク リ ッ ク します。

X-Ref Target - Figure 3-5

図 3-5 : 接続された割り込みを示す [Interrupt Connection] ダイアログ ボックス

X-Ref Target - Figure 3-6

図 3-6 : ファブリ ック側で接続されたタイマー割り込み

X-Ref Target - Figure 3-7

図 3-7 : 接続された chipscope_axi_monitor
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f. [System Assembly] ビューで [Ports] タブをク リ ッ ク し、[processing_system7_0] を展開します。GPIO ポー
トが外部ポートに接続されていないこ とがわかり ます。

21. [(IO_IF)GPIO_0] を展開し、 [GPIO] を選択します。

22. [Connected Port] 列でド ロ ップダウン リ ス トの矢印をク リ ッ ク し、 [External Ports] を選択します。

この接続によって、 この章の後半のユーザー制約ファイル (UCF) で PL のピン位置が PS GPIO に割り当てられま
す。

23. デザイン ルール チェッ クを実行します。 コンソールにエラーがないこ とを確認します。

注記 : エラーがある場合は、 実行した手順を再度確認します。

24. XPS を閉じます。 PlanAhead™ デザイン ツール ウ ィンド ウが再度アクティブになり ます。

25. [Design Sources] でエンベデッ ド  ソースをク リ ッ ク してから右ク リ ッ ク し、 [Create Top HDL] をク リ ッ ク します。
PlanAhead ツールによって system_stub.v ファ イルが生成されます。

26. Flow Navigator の [Project Manager] リ ス トで [Add Sources] を選択します。

27. ダイアログ ボッ クスが開くので、 [Add or Create Constraints] をオンにしてから  [Next] をク リ ッ ク します。

28. [Create File] をク リ ッ ク します。 [Create Constraints File] ダイアログ ボッ クスが開くので、 ファイル名に 「system」
と入力して [OK] をク リ ッ ク します。

29. [Finish] をク リ ッ ク します。

X-Ref Target - Figure 3-8

図 3-8 : 外部ポートに接続されていない GPIO ポート

X-Ref Target - Figure 3-9

図 3-9 : デザイン  ルール チェ ックの警告メ ッセージ
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30. [Sources] ウ ィンド ウで [Constraints] フォルダーを展開します。空の system.ucf ファ イルが constrs_1 に追加
されているこ と確認します。

31. UCF ファ イルで次のテキス ト を入力します。

# Connect to Push Button "SW5"
NET axi_gpio_0_GPIO_IO_pin IOSTANDARD=LVCMOS25 | LOC=G19;
# Connect to Push Button "SW7"
NET processing_system7_0_GPIO_pin IOSTANDARD=LVCMOS25 | LOC=F19;

次のよ うに設定されます。

° NET 「axi_gpio_0_IO_pin」 の LOC 制約によって、 AXI GPIO ピンが PL の G19 ピンに接続され、 さ らにその
ピンがボード上の SW5 プッシュ  ボタンに物理的に接続されます。

° NET 「processing_system7_0 GPIO pin」 の LOC 制約によって、 PS の GPIO が PL の F19 ピンに接続され、 さ
らにそのピンがボード上の SW7 プッシュ  ボタンに物理的に接続されます。

° IOSTANDARD=LVCMOS25 制約によって、 いずれのピンも  LVCMOS 2.5V I/O 規格に設定されます。

32. 変更したファイルをすべて保存します。

33. [Flow Navigator] の [Program and Debug] リ ス トで [Generate Bitstream] を選択します。 表示される警告メ ッセージ
はすべて無視します。

34. ビッ ト ス ト リームの生成が完了したら、 第 2 章の説明に従ってハード ウェアをエクスポート して SDK を起動し
ます。 このデザインについては、 PL ファブ リ ッ ク用に生成されたビッ ト ス ト リームがあるため、 これも  SDK へ
エクスポート されます。

X-Ref Target - Figure 3-10

図 3-10 : system.ucf ファイルの追加
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関連する ト レーニング演習

このチュート リ アルに関連する ト レーニング演習は、 『Zynq-7000 All Programmable SoC ハードウェア開発』 です。

この演習では、 Zynq™ All Programmable SoC のエンベデッ ド  システムの作成やプロセッシング システム (PS) および
プログラマブル ロジッ ク  (PL) にあるペリ フェラルの使用に推奨されるエンベデッ ド  デザイン フローについて学習
します。

ト レーニング演習情報へのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。

3.1.2 チュート リアル : SDK を使用する

1. SDK は、 第 2 章でスタンドアロン PS を用いて作成した Hello World プロジェク トで起動します。

2. [Project] → [Clean] をク リ ッ ク し、 プロジェク ト を消去して再度構築します。

3. helloworld.c ファイルを開き、 29 ページの 「デザイン用のスタンドアロン アプリ ケーシ ョ ン ソフ ト ウェア」
の説明に従ってアプリ ケーシ ョ ン ソフ ト ウェア コードを変更します。

4. ボー レート を 115200 に設定したシ リ アル通信ユーティ リ ティ を開きます。

5. ボードを接続します。

6. PL ファブ リ ッ クのビッ ト ス ト リームがすでにあるため、 これをダウンロード します。 [Xilinx Tools] → [Program
FPGA] をク リ ッ ク します。 図 3-11 に示す [Program FPGA] ダイアログ ボッ クスが開きます。 PlanAhead からエク
スポート されたビッ ト ス ト リームが表示されます。

7. [Program] をク リ ッ ク し、 ビッ ト ス ト リームをダウンロード して PL ファブ リ ッ クをプログラムします。

8. 17 ページの 「チュート リ アル : Hello World アプリ ケーシ ョ ンを実行する」 の手順と同じよ うにプロジェク ト を実
行します。

9. システムでは、AXI GPIO ピンがボード上のプッシュ  ボタン SW5 に接続され、PS の GPIO ピンが EMIO インター
フェイスを介してボード上のプッシュ  ボタン SW7 に接続されます。

10. シ リアル ターミナルの手順に従ってアプリ ケーシ ョ ンを実行します。

X-Ref Target - Figure 3-11

図 3-11 : [Program FPGA] ダイアログ ボックス

http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 29
UG873 (v14.6) 2013 年 6 月 19 日

デザイン用のスタンドアロン アプリケーシ ョ ン ソフ トウェア

3.2 デザイン用のスタンドアロン  アプリケーシ ョ ン  
ソフ トウェア
この章で設計したシステムをボードで実行するには、アプリ ケーシ ョ ン ソフ ト ウェアが必要です。 こ こでは、アプ リ
ケーシ ョ ン ソフ ト ウェアについて詳細に説明します。

アプリ ケーシ ョ ン ソフ ト ウェアの main() 関数は、 実行のエン ト リ  ポイン トです。 この関数は、 初期化およびシス
テムで接続されるすべてのペリ フェラルに必要な設定を含みます。 さ らに、 AXI GPIO や EMIO インターフェイスを
使用する  PS GPIO などのユース  ケースを選択するための手順が含まれます。 シ リ アル ターミナルの手順に従ってさ
まざまなユース  ケースを選択できます。

3.2.1 アプリケーシ ョ ン  ソフ トウェアの構成手順

アプリ ケーシ ョ ン ソフ ト ウェアは次の手順で構成されます。

1. AXI GPIO モジュールを初期化します。

2. AXI GPIO ピンが入力ピンとなるよ うに方向を設定します。 このピンは、 ボード上の SW5 プッシュ  ボタンに接
続されます。 このピン位置はシステムの構築中にユーザー制約ファイル (UCF) の LOC 制約で固定します。

3. AXI TIMER モジュールをデバイス  ID 0 で初期化します。

4. タイマー コールバッ ク関数を AXI timer ISR と関連付けます。

この関数は、 タイマーの割り込みが発生するたびに呼び出されます。 このコールバッ クによ り、ボード上の LED
DS23 がオンになり、 割り込みフラグがセッ ト されます。

main() 関数は割り込みフラグを用いて実行を停止し、 タイマー割り込みの発生を待機した後に実行を再開しま
す。

5. タイマーのリセッ ト値を設定します。この値は、リセッ トおよびタイマーの開始時にタイマーへロード されます。

6. Interrupt モードや Auto Reload モードなどのタイマー オプシ ョ ンを設定します。

7. PS の GPIO を初期化します。

8. PS の GPIO (チャネル 0、 ピン番号 10) を出力ピンに設定します。 このピンは MIO ピンにマップされ、 ボード上
の LED DS23 に物理的に接続されます。

9. PS の GPIO (チャネル 2、 ピン番号 0) を入力ピンに設定します。 このピンは、 EMIO インターフェイスを介して
PL 側のピンにマップされ、 SW7 プッシュ  ボタン スイ ッチに物理的に接続されます。

10. スヌープ制御ユニッ トであるグローバル割り込みコン ト ローラーを初期化します。タイマー割り込みルーチンを
割り込み ID 91 に設定し、 例外ハンド ラーを登録して割り込みを有効にします。

11. ループの中でシーケンスを実行し、 シ リ アル ターミナルで AXI GPIO または PS GPIO いずれかのユース  ケース
を選択します。

ソフ ト ウェアは、 選択したユース  ケースをシ リ アル ターミナルから受け取り、 適宜手順を実行します。

シ リ アル ターミナルでユース  ケースを選択した後、 ターミナルの手順に従ってボード上のプッシュ  ボタンを押
します。 LED DS23 をオフにする と、 タイマーが開始してタイマー割り込みが発生するまで関数を無限に待機さ
せます。 タイマー割り込みの発生後、 LED DS23 がオンになって実行が再開されます。

API に関連するデバイス  ド ラ イバーの詳細は、 『Zynq-7000 ソフ ト ウェア開発者向けガイ ド』 (UG821) を参照してくだ
さい。 この資料へのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。
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3.2.2 アプリケーシ ョ ン  ソフ トウェアのコード

システムのアプ リ ケーシ ョ ン ソ フ ト ウ ェアは、 このガイ ド で提供されている  ug873_design_files.zip の
helloworld.c から入手できます。 この ZIP ファ イルへのリ ンクは、 付録 A 「その他のリ ソース」 に記載されてい
ます。
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第 4 章

SDK および ChipScope を使用したデバッグ
この章では、 これまで説明してきたデザイン フローで可能な 2 通りのデバッグについて説明します。 1 つ目は、 SDK
を使用してソフ ト ウェアでデバッグする方法です。2 つ目の方法は、ChipScope™ ツールでサポート されるハード ウェ
ア デバッグです。

4.1 チュート リアル : SDK を使用して
ソフ トウェアをデバッグする
まずは、 SDK を使用してソフ ト ウェアのデバッグを実行します。

1. C/C++ 用の表示では、 Hello_world プロジェク ト上で右ク リ ッ ク して [Debug As] → [Launch on Hardware (System
Debugger)] をク リ ッ ク します。

[Debug] ウ ィンド ウが開きます。

注記 : [Debug] ウ ィンド ウが自動的に開かない場合は、[Window] → [Open Perspective] → [Other] をク リ ッ ク してか
ら  Open Perspective ウ ィザードの [Debug] をク リ ッ ク します。

注記 : このページに示されているアドレスは、 システムで表示されているものと若干異なる場合があ り ます。

プロセッサが main() の始め部分にあ り、 プログラム実行が 0x001004ec で停止しているこ とがわかり ます。 こ
の情報は [Disassembly] ビューで確認でき ます。 こ こでは、 アセンブ リ  レベルのプログラム実行についても
0x001004ec で一時停止されているこ とがわかり ます。

注記 : [Disassembly] ビューが表示されない場合は、 [Window] → [Show view] → [Disassembly] をク リ ッ ク します。

また、 helloworld.c ウ ィンド ウに実行が C コードの最初の実行可能な行で一時停止しているこ とが表示されます。
[Registers] ビューを選択し、 プログラム カウンターである  pc レジスタが 0x001004ec を含むこ とを確認します。 

X-Ref Target - Figure 4-1

図 4-1 : [Debug] ウィンドウの一時停止
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注記 : [Registers] ウ ィンド ウが表示されない場合は、 [Window] → [Show View] → [Registers] をク リ ッ ク します。

2. init_platform () を読み出すコードの行の横にある、 helloworld.c ウ ィンド ウの空白をダブルク リ ッ ク しま
す。 これによ り、 init_platform () でブレークポイン ト が設定されます。 ブレークポイン ト の確認には、
[Breakpoints] ウ ィンド ウを参照します。 

注記 : [Breakpoints] ウ ィンド ウが表示されない場合は、 [Window] → [Show View] → [Breakpoints] をク リ ッ ク しま
す。

3. [Run] → [Resume] をク リ ッ ク し、 ブレークポイン ト までプログラムの実行を再開させます。 

プログラムの実行は、 init_platform () を含むコードの行で停止します。 [Disassembly] および [Debug] の両
ウ ィンド ウで、 プログラムの実行が 0x001004f4 で停止しているこ とが示されます。

4. [Run] → [Step Into] をク リ ッ ク し、 init_platform () ルーチンへステップインします。

プログラムの実行が 0x00100554 の位置で一時停止します。 コール スタ ッ クはこ こで 2 レベル分の深さです。

5. [Run] → [Resume] を再度ク リ ッ ク し、 プログラムを終了まで実行します。

プログラムの実行が完了する と、 [Debug] ウ ィンド ウはプログラムが exit とい うルーチンで一時停止している
こ とを示します。 これは、 デバッガーの制御下で実行している と きに発生します。

6. コードを複数回再実行します。 シングル ステップ、 メモ リの検査、 ブレークポイン ト、 コードの変更、 および
print 文の追加を試してみます。 ビューの追加および移動を試します。

7. SDK を閉じます。

関連する ト レーニング演習

このチュート リ アルに関連する演習は 『Zynq-7000 All Programmable SoC デザイン ワークシ ョ ップ : ベア メ タル ソフ
ト ウェア開発』 です。

この演習では、 次について学習します。

• ハードウェア記述を SDK にインポートする

• BSP を作成およびカスタマイズする

• SDK を使用してソフ ト ウェアをダウンロード、 デバッグ、 および実行する

• 簡単なアプリ ケーシ ョ ンのプロファ イルを実行し、 ソフ ト ウェアで時間がかかっている場所を特定する

• チップのデバッグを実行し、 ChipScope Pro Analyzer を使用して AXI ト ランザクシ ョ ンを確認する

ト レーニング演習情報へのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。

4.2 チュート リアル : ChipScope ツールを使用
してハードウェアをデバッグする
次に、 「3.1.2 チュート リ アル : SDK を使用する」 で作成した同じアプリ ケーシ ョ ン使用し、 ChipScope ツールでハー
ドウェアのデバッグを実行します。

1. 「3.1.2 チュート リ アル : SDK を使用する」 の記載に従って、 ビッ ト ス ト リームとアプリ ケーシ ョ ンを ZC702 に
再度ダウンロード します。

2. アプリ ケーシ ョ ンを実行して SDK を閉じます。

3. ChipScope Pro™ Analyzer を開きます。
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4. ハードウェアが Digilent 社製ケーブル経由でコンピューターの USB ポートへ接続されているこ とを確認します。
ケーブル デバイス  ド ラ イバーもインス トールしておく必要があ り ます。

5. [JTAG Chain] → [Open Plug-in] をク リ ッ ク します。

Open Plug-in ウ ィザードが開きます。

6.  Plug-in パラ メーターに 「xilinx_tcf url=tcp:」 と入力します。

7. [OK] をク リ ッ ク します。

8. *.cdc ファ イルを ChipScope でインポート し、 次を実行します。

a. [Dev 1 Mydevice1(XC7020)] を選択します。

b. [File] → [Import] をク リ ッ ク します。

c. [Select New File] をク リ ッ ク して Chipscope_axi_monitor_0.cdc ファ イルを <project_path>\
<project_name>.srcs\sources_1\edk\system\implementation\chipscope_axi_monitor_0

_wrapper から選択します。

d. [OK] をク リ ッ ク します。

9. [Open/Search JTAG Cable]  をク リ ッ ク します。

10. [OK] をク リ ッ ク します。

11. 次のよ うに、 ARVALID 信号にト リガーを設定します。

a. [Trigger Setup] ウ ィンド ウを展開します。

b. M1:MON_AXI_ARADDRCONTROL ユニッ トで、 axi_gpio_0_S_AXI/MON_AXI_AVALID の値をデフォルトの
X から  1 に変更します。 これによ り、 この信号での有効な ト ランザクシ ョ ンによって波形が生成されます。

c. [Trigger Setup] ウ ィンド ウの [Trig] セクシ ョ ンで、 [Trigger Condition Equation] 列の [M0] をク リ ッ ク します。

[Trigger Condition] ダイアログ ボッ クスが開きます。

d. [Enable] 列で [M0] をオフにして [M1] をオンにします。

X-Ref Target - Figure 4-2

図 4-2 : [Trigger Setup] ウィンドウ : MON_AXI_AVALID の設定

http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 34
UG873 (v14.6) 2013 年 6 月 19 日

チュート リアル : ChipScope ツールを使用してハードウェアをデバッグする

ト リ ガー チャネルが M0 から  M1 に変更され、 ARVALID 信号が M1 チャネル上に現れます。

12. [OK] をク リ ッ ク します。

13. [Trigger Setup] ウ ィンド ウの [Capture] セクシ ョ ンで、 [Position] の設定を  0 から  512 に変更します。

サンプルのワード数が 1024 に変更されるので、 ト リガー ポイン トが波形の中央に移動します。

14. [Run] をク リ ッ ク します。

ChipScope Analyzer はト リガー イベン ト を待機します。

15. シ リアル ターミナルの手順に従って AXI GPIO ユース  ケースを選択します。 これによ り、 波形が生成されます。

X-Ref Target - Figure 4-3

図 4-3 : [Trigger Condition] ダイアログ ボックス

X-Ref Target - Figure 4-4

図 4-4 : 波形
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関連する ト レーニング演習

このチュート リ アルに関連する ト レーニング演習は、 『Zynq-7000-7000 All Programmable SoC デザイン ワークシ ョ ッ
プ : ベア メ タル ソフ ト ウェア開発』 です。

この演習では、 次について学習します。

• ハードウェア記述を SDK にインポートする

• BSP を作成およびカスタマイズする

• SDK を使用してソフ ト ウェアをダウンロード、 デバッグ、 および実行する

• 簡単なアプリ ケーシ ョ ンのプロファ イルを実行し、 ソフ ト ウェアで時間がかかっている場所を特定する

• チップのデバッグを実行し、 ChipScope Pro Analyzer を使用して AXI ト ランザクシ ョ ンを確認する

ト レーニング演習情報へのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。
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第 5 章

SDK を使用した Linux のブートおよび
アプリケーシ ョ ンのデバッグ

この章では、 Zynq®-7000 AP ボード上で Linux OS をブートする手順を説明します。 また、 JTAG インターフェイスを
使用してターゲッ ト  メモ リ上で Linux によってコンパイル済みのイ メージをダウンロードする方法を提供します。こ
の章の後半では、 Linux でコンパイル済みのイ メージがロード されている次の不揮発性メモ リ をプログラムする方法
について説明します。 これらのイ メージは、 ボードをオンにした後に Linux の自動ブートに使用されます。

• オンボード  QSPI フラ ッシュ

• SD カード

さ らに、SDK のリモート  デバッグ機能を用いて、ターゲッ ト  ボードで実行している  Linux アプリ ケーシ ョ ンをデバッ
グする方法について解説します。 SDK ソフ ト ウェア ツールは Windows ホス ト  マシンで実行します。 アプリ ケーシ ョ
ンのデバッグの場合、 Linux OS をすでに実行しているターゲッ ト  ボードへのイーサネッ ト接続が SDK によって確立
されます。

5.1 必要な環境
この章では、 ターゲッ ト  プラ ッ ト フォームは Zynq ボードを指します。 ホス ト  プラ ッ ト フォームは ISE® Design Suite
ツールを実行する  Windows マシンのこ とです。

注記 : この章のチュート リ アルには、 一般的なブート ローダーである  Das U-Boot が必要です。 これは、 次にダウン
ロードするコンパイル済みのイ メージに含まれます。

ザイ リ ンクスの資料サイ トから、 ug873-design-files.zip ファ イルをダウンロード します。 この資料へのリ ン
クは、 付録 A 「その他のリ ソース」 に記載されています。 この ZIP ファ イルには、 次のファイルが含まれています。

• BOOT.bin : bootgen で生成された FSBL および U-Boot イ メージを含むバイナリ  イ メージ

• cdma_app : 第 6 章で作成するシステム用のスタンドアロン アプリ ケーシ ョ ン ソフ ト ウェア

• devicetree.dtb : Linux が使用するデバイス  ツ リーのバイナリ  ラージ オブジェク ト  (blob)、 U-Boot でメモ リ
にロード される

• helloworld.c : 第 3 章で作成したシステム用のスタンドアロン アプリ ケーシ ョ ン ソフ ト ウェア

• linux_cdma_app : 第 6 章で作成するシステム用の Linux OS ベースのアプリ ケーシ ョ ン ソフ ト ウェア

• uramdisk.image.gz : Linux が使用する  Ramdisk イ メージ、 U-Boot でメモ リにロード される

• README.txt : リ リースの説明

• u-boot.elf : BOOT.BIN イ メージの作成に使用する  U-Boot ファ イル 

• uImage : Linux カーネル イ メージ、 U-Boot でメモ リにロード される

• zync_fsbl_0.elf : BOOT.BIN イ メージの作成に使用する  FSBL イ メージ

• stub.tcl : 「5.2.3 チュート リ アル : JTAG モードで Linux をブートする」の手順で使用するスク リプ ト  ファ イル
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5.2 Zynq ボード上で Linux をブートする
このセクシ ョ ンでは、 「5.1 必要な環境」 でダウンロード したコンパイル済みのイ メージを使用し、 ターゲッ ト  ボー
ド上で Linux をブートするフローについて説明します。

注記 : カーネル イ メージ、 U-Boot、 デバイス  ツ リー、 ルート  ファ イルなどのさまざまなイ メージのコンパイルにつ
いては、 このガイ ドでは割愛します。

5.2.1 ブート方法

次の 2 通りの方法でブート可能です。

• マスター ブート方法

• スレーブ ブート方法

マスター ブート方法

マスター ブート方法では、 QSPI、 NAND、 NOR フラ ッシュ、 および SD カードなどの異なる種類の不揮発性メモ リ
にブート  イ メージを保存できます。 この方法で、 CPU は外部のブート  イ メージを不揮発性メモ リからプロセッサ シ
ステム (PS) にロード して実行します。マスター ブート方法は、 さ らにセキュア モード と非セキュア モードがあ り ま
す。 詳細は、 『Zynq-7000 All Programmable SoC テクニカル リ ファレンス  マニュアル』 (UG585) を参照して ください。
この資料へのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。

ブート  プロセスは、プロセッシング システム (PS) にある  ARM Cortex-A9 CPU のうちの 1 つによって開始され、オン
チップ ROM コードを実行します。 このオンチップ ROM コードが、 FSBL (第 1 段階ブート ローダー ) をロード しま
す。 FSBL は次を実行します。

• ハードウェア ビッ ト ス ト リームがある場合は、 これで FPGA をコンフ ィギュレーシ ョ ンする

• MIO インターフェイスをコンフ ィギュレーシ ョ ンする

• DDR コン ト ローラーを初期化する

• ク ロ ッ ク  PLL を初期化する

• Linux の U-Boot イ メージを不揮発性メモ リから  DDR へロード して実行する

U-Boot はカーネル イ メージ、 ルート  ファ イル システムおよびデバイス  ツ リーを不揮発性 RAM から  DDR へロード
し、 これらの実行を開始します。 ターゲッ ト  プラ ッ ト フォームでの Linux のブート を終了させます。

スレーブ ブート方法

JTAG は、 スレーブ ブート  モードでしか使用できません。 外部のホス ト  コンピューターがマスターと して動作し、
JTAG 接続を使用してブート  イ メージを OCM へロード します。

注記 : ブート  イ メージのロード中、 PS CPU はアイ ドル モードのままです。 スレーブ ブート方法でのブートは常に非
セキュア モードです。

JTAG ブート  モードでは、 CPU はセキュ リ ティ関連のすべてのアイテムへのアクセスを無効にし、 JTAG ポート を有
効にした直後に停止モードに遷移します。 CPU の実行を再開させる前に、 ブート  イ メージを DDR メモ リにダウン
ロードする必要があ り ます。
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5.2.2 JTAG から  Linux をブートする

次のフロー図は、 ターゲッ ト  プラ ッ ト フォームで Linux をブートするためのプロセスを示しています。

X-Ref Target - Figure 5-1

図 5-1 : ターゲッ ト  プラッ ト フォームでの Linux ブート  プロセス
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5.2.3 チュート リアル : JTAG モードで Linux をブートする

1. JTAG モードを使用して Linux をブートする場合は、 次のボード接続および設定を確認してください。

° 17 ページの 「チュート リ アル : Hello World アプリ ケーシ ョ ンを実行する」 の説明に従って、 ジャンパー J27
および J28 が設定されているこ とを確認します。

° 図 5-2 に示すとおりに SW16 スイ ッチが設定されているこ とを確認します。

° Zynq ボードからのイーサネッ ト  ケーブルをネッ ト ワークに接続します。

° Windows ホス ト  マシンをネッ ト ワークに接続します。

° 電源ケーブルをボードに接続します。

2. Digilent 社製ケーブルを使用して Windows ホス ト  マシンと、 SW10 スイ ッチを次のよ うに設定したターゲッ ト
ボードを接続します。

° ビッ ト  1 : 0

° ビッ ト  2 : 1

注記 : 0 = 開スイ ッチ1 = 閉スイ ッチ

3. USB ケーブルを Windows ホス ト  マシンと ターゲッ ト  ボードのコネクタ  J17 につなぎます。シ リ アル転送に USB
を使用する際はこのよ うに接続します。

4. 図 5-3 のよ うにイーサネッ ト  ジャンパー J30 および J43 を変更します。

X-Ref Target - Figure 5-2

図 5-2 : SW16 スイッチの設定の確認
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5. ターゲッ ト  ボードに電源を投入します。

6. SDK を起動し、 第 2 章および第 3 章と同じワークスペースを開きます。

7. シ リアル ターミナルが開かない場合は、ボー レート を 115200 に設定したシ リ アル通信ユーティ リ ティ を接続し
ます。

8. [Xilinx Tools] → [Program FPGA] をク リ ッ ク してから  [Program] をク リ ッ ク し、 ビッ ト ス ト リームをダウンロード
します。

9. [Xilinx Tools] → [XMD console] をク リ ッ ク して XMD ツールを開きます。

10. XMD プロンプ トで次を実行します。

a. 「connect arm hw」 と入力して PS の CPU1 に接続します。

b. 「source <Project Dir>/project_1/project_1.sdk/SDK/SDK_Export/」 と入力します。
「system_hw_platform/ps7_init.tcl」 と入力した後、 「ps7_init」 と入力して PS を初期化します (ク ロ ッ ク  PLL、
MIO、 および DDR などの初期化) 。

c. 「ps7_post_config」 と入力し、 PS と  PL 間のレベル シフターを有効にしてファブ リ ッ ク  ポート  リセッ ト をク
リ アします。

d. 「source stub.tcl」 と入力します。

CPU2 は CPU1 からのイベン ト を継続的に待機します。

注記 : stub.tcl ファ イルは、 このガイ ドで提供されている  ug873-design-files.zip から入手できま
す。 この ZIP ファ イルへのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。

e. 「target 64」 と入力して実行制御を CPU1 に与えます。

X-Ref Target - Figure 5-3

図 5-3 : ジャンパー J30 および J43 の変更
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f. 「dow <path>/u-boot.elf」 と入力して Linux U-Boot をダウンロード します。

g. 「con」 と入力して U-Boot の実行を開始します。

シ リ アル ターミナルに、 次のよ うな自動ブート  カウン ト ダウン メ ッセージが表示されます。

?Hit any key to stop autoboot:3

h. [Enter] をク リ ッ ク します。

U-Boot からの自動ブートが停止し、 シ リ アル ターミナルにコマンド  プロンプ トが表示されます。

i. XMD プロンプ トに 「stop」 と入力します。

U-Boot の実行が停止します。

j. 「dow -data uImage 0x3000000」 と入力し、 Linux カーネル イ メージを 0x3000000 にダウンロード します。

k. 「dow -data uramdisk.image.gz 0x2000000」と入力し、Linux のルート  ファ イル システムのイ メージを 0x2000000
にダウンロード します。

l. 「dow -data devicetree.dtb 0x2A00000」と入力し、Linux のデバイス  ツ リーを 0x2A00000 にダウンロード します。

m. 「con」 と入力して U-Boot の実行を開始します。

11. シ リアル ターミナルのコマンド  プロンプ トに 「bootm 0x3000000 0x2000000 0x2A00000」 と入力します。
Linux OS が起動します。

12. 必要に応じてシ リアル ターミナルで Zynq のログインと して 「root」 を、 パスワード と して 「root」 を入力し、 プ
ロセッサのブート を完了させてください。
ブートが完了する と、 # prompt プロンプ トがシ リ アル ターミナルに表示されます。

13. Zynq> プロンプ トで次を実行します。

a. Zynq> プロンプ トで次のコマンドを入力してボードの IP アドレスを確認します。
ifconfig eth0

このコマンドは、現時点でアクティブなインターフェイスの詳細をすべて表示します。表示される メ ッセー
ジでは、 inet addr 値は Zynq ボードに割り当てられている  IP アドレスを示しています。

b. Windows マシンのコマンド  プロンプ トで 「ping」 と入力した後にボードの IP アドレスを入力し、 ボード と
の接続を確認します。 ping 応答がループ内に表示されます。

この応答は、 Windows ホス ト  マシンと ターゲッ ト  ボード間の接続が確立されているこ とを意味します。

c. Ctrl+C キーを押して ping 応答の表示を停止させます。

ターゲッ ト  ボードでの Linux のブートが終了し、ホス ト  マシンと ターゲッ ト  ボード間の接続が完了します。
次のチュート リ アルでは、 SDK を使用して Linux アプリ ケーシ ョ ンをデバッグする方法を説明します。

関連する ト レーニング演習

このチュート リ アルに関連する演習は 『Zynq プラ ッ ト フォームでの Linux アプリ ケーシ ョ ンの実行およびデバッグ』
です。

この演習では、 次について学習します。

• ハードウェア記述を SDK にインポートする

• Linux ソフ ト ウェア アプリ ケーシ ョ ンを作成および構築する

• SDK を使用してソフ ト ウェアをダウンロード、 デバッグ、 および実行する

ト レーニング演習情報へのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。
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5.2.4 チュート リアル : SDK リモート  デバッグを使用して 
Linux アプリケーシ ョ ンをデバッグする

このセクシ ョ ンでは、 SDK を使用してデフォルトの Linux hello world アプリ ケーシ ョ ンを作成し、 Windows ホス
ト  マシンから  Linux アプリ ケーシ ョ ンをデバッグする手順を実行します。

1. SDK が開かれていない場合は、 こ こで開きます。

2. [File] → [New] → [Application Project] をク リ ッ ク します。
New Project ウ ィザードが開きます。

3. 次の表の情報に基づいて、 ウ ィザード画面で選択操作を行います。

4. [Finish] をク リ ッ ク します。

New Project ウ ィザードが閉じ、SDK によって linux_hello_world プロジェク トが [Project Explorer] の下に作成され
ます。 また、自動的にこのプロジェク トがコンパイルされて linux_hello_world.elf ファ イルが生成されま
す。

5. [linux_hello_world] を右ク リ ッ ク して [Debug as] → [Debug Configurations] をク リ ッ ク します。

Debug Configuration ウ ィザードが開きます。

6. Debug Configuration ウ ィザードで、 [Remote ARM Linux Application] を右ク リ ッ ク して [New] をク リ ッ ク します。
[Connection] ド ロ ップダウン リ ス トで [New] を選択します。

New Connection ウ ィザードが開きます。

7. [SSH Only] タブをク リ ッ ク して [Next] をク リ ッ ク します。

8. [Host Name] タブでターゲッ ト  ボード  IP を入力します。

注記 : ターゲッ ト  IP を確認するには、 シ リ アル ターミナルの Zynq> プロンプ トで 「ipconfig eth0」 と入力しま
す。 ボードに割り当てられているターゲッ ト  IP がシ リ アル ターミナルに表示されます。

9. 接続の名前および説明を、 それぞれに対応するタブで設定します。

10. [Finish] をク リ ッ ク して接続を作成します。

11. Debug Configuration ウ ィザードで、[Remote Absolute File Path for C/C++ Application] の下にある  [Browse]  をク リ ッ
ク します。 Select Remote C/C++ Application File ウ ィザードが開きます。

12. ウ ィザードで次を実行します。

a. ルート  ディレク ト リ を展開し、 Enter Password ウ ィザードを開きます。

b. ユーザー ID およびパスワード  (root/root) を入力し、 [Save ID] および [Save Password] をオンにします。

c. [OK] をク リ ッ ク します。

注記 : 表示される警告メ ッセージは、 [YES] をク リ ッ ク して閉じても問題あ り ません。

ウィザード画面 システム プロパティ 使用する設定コマンド

Application Project

Project Name linux_hello_world

Use Default Location このオプシ ョ ンをオンにする。

Hardware Platform system_hw_platform

Processor PS7_cortexa9_0

OS Platform Linux

Language C

Templates Available Templates Linux Hello World
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Windows ホス ト  マシン と ターゲッ ト  ボード間の接続がすでに確立されているため、 ウ ィ ン ド ウにルー ト
ディ レク ト リの内容が表示されます。

d. パス名の 「/」 で右ク リ ッ ク し、 新しいフォルダーを 「Apps」 とい う名前で作成します。

e. [Remote Absolute File Path for C/C++ Application] の下に、 「/Apps/linux_hello_world.elf」 とい うパス
を入力します。

13. [Apply] をク リ ッ ク します。 

14. [Debug] をク リ ッ ク します。 

[Debug] ウ ィンド ウが開きます。

15. 31 ページの 「チュート リ アル : SDK を使用して ソフ ト ウェアをデバッグする」 に従ってデバッグを実行します。

注記 : Linux アプリ ケーシ ョ ンの出力は、Linux を実行するために使用したターミナル ウ ィンド ウではなく、SDK
コンソールに表示されます。

16. Linux アプリ ケーシ ョ ンのデバッグ終了後、 SDK を閉じます。

5.2.5 チュート リアル : QSPI フラッシュから  Linux をブー
トする

このチュート リ アルでは次を実行します。

1. 第 1 段階ブート  ローダーの実行ファイルを作成する

2. QSPI フラ ッシュ用に Linux のブート可能なイ メージを作成する

3. JTAG および U-Boot コマンドを使用し、 ブート  イ メージで QSPI フラ ッシュをプログラムする

4. QSPI フラ ッシュから  Linux をブートする

第 1 段階ブート  ローダーの実行ファイルを作成する

1. SDK が開かれていない場合は、 こ こで開きます。

2. SDK の場合、TCF エージェン ト をホス ト  マシンで実行します。[Xilinx Tool] → [Launch Hardware Server] をク リ ッ
ク します。

3. SDK で [File] → [New] → [Xilinx C Project] をク リ ッ ク します。

New Project ウ ィザードが開きます。

4. 次の表の情報に基づいて、 ウ ィザード画面で選択操作を行います。

ウィザード画面 システム プロパティ 使用する設定コマンド

Application Project

Project Name zynq_fsbl_0

Use Default Location このオプシ ョ ンをオンにする。

Hardware Platform system_hw_platform

Processor PS7_cortexa9_0

OS Platform スタンドアロン

Language C

Board Support Package [Create New] をク リ ッ ク して
「zynq_fsbl_0_bsp」 とい う名前を付ける。

Templates Available Templates Zynq FSBL
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5. [Finish] をク リ ッ ク します。

New Project ウ ィ ザー ド が閉じ ます。 SDK によ って zynq_fsbl_0 アプ リ ケーシ ョ ン プロ ジェ ク ト および
zynq_fsbl_0_bsp BSP プロジェク トが [Project Explorer] の下に作成されます。 また、 自動的にこのプロジェク トが
コンパイルされて zynq_fsbl_0.elf ファ イルが生成されます。

QSPI フラ ッシュ用に Linux のブート可能なイメージを作成する

1. SDK で [Xilinx Tools] → [Create Zynq Boot Image] をク リ ッ ク します。

Create Zynq Boot Image ウ ィザードが開きます。

2. [FSBL ELF] タブで zynq_fsbl_0.elf へのパスを提供します。

注記 : zynq_fsbl_0.elf は、 
<project dir>/project_1/project_1.sdk/SDK/SDK_Export/zynq_fsbl_0/Debug にあ り ます。

「5.1 必要な環境」 でダウンロード したファ イルから  zynq_fsbl_0.elf を使用するこ と もできます。

注記 : u-boot.elf、 uImage.bin、 devicetree.dtb、 および uramdisk.image.gz のファイルはこのガイ
ドで提供されている  ug873-design-files.zip から入手できます。 この ZIP ファ イルへのリ ンクは、 付録 A
「その他のリ ソース」 に記載されています。

3. U-Boot イ メージの u-boot.elf を追加します。

4. uImage.bin などの Linux カーネル イ メージを追加し、 0x100000 オフセッ トに指定します。

重要 : Bootgen コマンドには既知の問題があ り ます。 このコマンドはファ イル拡張子なしのファ イルを受け入れませ
ん。 この問題を回避するには、 ダウンロード した uImage ファ イルを  uImage.bin に変更してください。

5. デバイス  ツ リー イ メージ (devicetree.dtb) を追加し、 - 0x600000 オフセッ トに指定します。

6. ルート  ファ イル システム イ メージ (uramdisk.image.gz) を追加し、 0x620000 オフセッ トに指定します。

提供したオフセッ トは U-Boot で定義済みのものです。U-Boot は、QSPI フラ ッシュからのブート時にこれらのア
ドレスを予測します。 オフセッ ト を変更する場合は、 U-Boot を変更して再構築する必要があ り ます。
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7. [Basic] タブで出力フォルダー名を入力します。

8. [Create Image] をク リ ッ ク します。

Create Zynq Boot Image ウ ィンド ウで、 指定した出力フォルダーに次のファイルが作成されます。

° bootimage.bif

° u-boot.bin

° u-boot.mcs 

JTAG および U-Boot コマンドを使用し、 ブート  イメージで QSPI フラッシュをプログ

ラムする

JTAG および U-Boot コマンドを使用し、 ブート  イ メージで QSPI フラ ッシュをプログラムできます。

ヒン ト : また、 iMPACT を使用して QSPI フラ ッシュをプログラムできます。 詳細は、 「iMPACT での Zynq-7000 All
Programmable SoC の操作」 を参照してください。

1. ZC702 ボードに電源を投入します。

2. シ リアル ターミナルが開かない場合は、 ボー レート を 115200 に設定したシ リ アル ターミナルを接続します。

3. [Xilinx Tools] → [XMD Console] をク リ ッ ク して XMD ツールを開きます。

4. XMD プロンプ トで次を実行します。

a. 「connect arm hw」 と入力して PS の CPU に接続します。

b. 「source <Project Dir>/project_1/project_1.sdk/SDK/SDK_Export/」 と入力します。
「system_hw_platform/ps7_init.tcl」 と入力した後、 「ps7_init」 と入力して PS セクシ ョ ンを初期化します。

c. 「ps7_post_config」 と入力して PS と  PL 間のレベル シフターを有効にし、 ファブ リ ッ ク  ポート  リセッ ト をク
リ アします。

X-Ref Target - Figure 5-4

図 5-4 : Zynq ブート  イメージの作成
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d. 「dow u-boot.elf」 と入力して Linux U-Boot を QSPI フラ ッシュにダウンロード します。

e. 「dow -data u-boot.bin 0x08000000」 と入力し、 Linux のブート可能なイ メージを 0x08000000 のターゲッ ト  メ
モ リにダウンロード します。

注記 : 2 進数の実行ファイルを DDR メモ リにダウンロードするだけです。 2 進数の実行ファ イルは DDR メ
モ リのいずれのアドレスにもダウンロードできます。

f. 「con」 と入力して U-Boot の実行を開始します。

シ リ アル ターミナルに、 次のよ うな自動ブート  カウン ト ダウン メ ッセージが表示されます。

?Hit any key to stop autoboot:3

5. [Enter] をク リ ッ ク します。

U-Boot からの自動ブートが停止し、 シ リ アル ターミナルに U-Boot コマンド  プロンプ トが表示されます。

6. 次の手順に従って U-Boot をブート可能なイ メージでプログラムします。

a. プロンプ トに 「sf probe 0 0 0」 と入力して QSPI フラ ッシュを選択します。

b. 「sf erase 0 0x01000000」 と入力してフラ ッシュ  データを消去します。

このコマンドによ り、 16MB のオンボード  QSPI フラ ッシュ  メモ リが完全に消去されます。

c. 「sf write 0x08000000 0 0xFFFFFF」 と入力して QSPI フラ ッシュにブート  イ メージを書き込みます。

ブート可能なイ メージが既に DDR の 0x08000000 に書き込まれているこ とを確認します。このコマンドによ
り、 ブート可能なイ メージと同じサイズのデータが、 DDR から  0x0 の QSPI にコピーされました。

16MB のフラ ッシュ  メモ リが対象のこの例では、 16MB のデータをコピーしたこ とにな り ます。 ブート可能
なイ メージのサイズは引数を変更して調整できます。

7. ボードへの電源を切断します。

QSPI フラ ッシュから  Linux をブートする

1. QSPI フラ ッシュのプログラム後、 ボードの SW16 スイ ッチを図 5-5 のよ うに設定します。

2. ボー レート を 115200 に設定したシ リ アル ターミナルを接続します。

X-Ref Target - Figure 5-5

図 5-5 : QSPI フラ ッシュから  Linux をブートする際に必要なジャンパーの設定
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3. ボード電源をオンにします。

Linux ブート  メ ッセージがシ リ アル ターミナルに表示されます。 ブート完了後、 Zynq> プロンプ トが表示され
ます。

4. 39 ページの 「チュート リ アル : JTAG モードで Linux をブートする」 の説明に従ってボード  IP アドレスの接続を
確認します。

Linux アプリ ケーシ ョ ンの作成およびデバッグは、42 ページの 「チュート リ アル : SDK リモート  デバッグを使用して
Linux アプリ ケーシ ョ ンをデバッグする」 を参照して ください。

5.2.6 チュート リアル : SD カードから  Linux をブートする

1. 図 5-6 に示すよ うに SW16 スイ ッチの設定を変更します。

2. ボードを 39 ページの 「チュート リ アル : JTAG モードで Linux をブートする」 の説明に従ってボードを設定しま
す。

3. 43 ページの 「第 1 段階ブート  ローダーの実行ファイルを作成する」 の説明に従ってデザインの FSBL を作成し
ます。

注記 : デフ ォル ト の FSBL イ メ ージを変更する必要がない場合、 このガイ ド の ZIP フ ァ イルに含まれる
zynq_fsbl_.elf ファ イルをダウンロード して使用できます。

4. SDK で [Xilinx Tools] → [Create Boot Image] をク リ ッ ク し、 Create Zynq Boot Image ウ ィザードを開きます。

ヒン ト : ダウンロード した zynq_fsbl_0.elf と  u-boot.bin ファ イルに変更がない場合は、 ダウンロード済みの
BOOT.bin ファ イルをブート可能なイ メージと して使用でき、 手順 5、 6、 および 7 を省略できます。

5. zynq_fsbl_0.elf および u-boot.elf を追加します。

X-Ref Target - Figure 5-6

図 5-6 : SD カードから  Linux をブートする際に必要なジャンパーの設定
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6. [Basic] タブで出力フォルダー名を入力します。

7. [Create Image] をク リ ッ ク します。 SDK によって u-boot.bin ファ イルが指定のフォルダーに生成されます。

8. u-boot.bin という ファ イル名を BOOT.bin に変更します。

9. BOOT.bin devicetree.dtb および uramdisk.image.gz を SD カードにコピーします。

重要 : ファ イル名は変更できません。 U-Boot は、 システムのブート中に SD カード内でこれらの名前でファイルを検
索します。

10. ボード電源を投入し、シ リ アル ターミナルに表示される メ ッセージを確認します。ターゲッ ト  ボードで Linux の
ブートが完了する と、 Zynq> プロンプ トが表示されます。

11. 39 ページの「チュート リ アル : JTAG モードで Linux をブートする」の説明に従ってボード  IP アドレスを設定し、
接続を確認します。

Linux アプリ ケーシ ョ ンの作成およびデバッグは、42 ページの 「チュート リ アル : SDK リモート  デバッグを使用して
Linux アプリ ケーシ ョ ンをデバッグする」 を参照してください。

X-Ref Target - Figure 5-7

図 5-7 : Zynq ブート  イメージを作成する
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第 6 章

プロセッシング システムの高性能スレーブ 
ポートを使用したシステム デザイン

この章では、プロセッシング システムの高性能 (HP) 64 ビッ ト  スレーブ ポート を用いて AXI CDMA IP をファブ リ ッ
クでインスタンシエート します。 このシステムでは、 AXI CDMA はマスター デバイス と して機能し、 多くのデータ
を転送元バッファーから  DDR システム メモ リの転送先バッファーへコピーします。AXI CDMA は、プロセッシング
システムの HP スレーブ ポート経由で DDR システム メモ リに対する読み出し /書き込みアクセスを実行します。

mmap() を用いてスタンドアロンのアプリ ケーシ ョ ン ソフ ト ウェアおよび Linux OS ベースのアプリ ケーシ ョ ン ソフ
ト ウェアを記述し、 AXI CDMA ブロ ッ クを使用するデータ転送を実現します。 また、 スタン ドアロンおよび Linux
ベースの両アプリ ケーシ ョ ン ソフ ト ウェアを ZC702 ボードで個別に実行します。

6.1 AXI CDMA を  Zynq PS の HP スレーブ ポート と
統合する
ザイ リ ンクスの Zynq®-7000 AP SoC デバイスは、4 つの高性能 (HP) AXI スレーブ インターフェイスを備えています。
これらを使用し、 広帯域幅データパスを用いるプログラマブル ロジッ ク  (PL) のバス  マスターをダブル データ  レー
ト  (DDR) のオンチップ メモ リに接続します。

4 つの高性能 (HP) スレーブ AXI インターフェイスを用いてプログラマブル ロジッ ク  (PL) をプロセッシング システ
ム (PS) の非同期 FIFO インターフェイス  (AFI) ブロ ッ クに接続します。 このよ うなモジュールを使用する目的は、 PL
の AXI マスターと  PS のメモ リ  システム (DDR およびオンチップ メモ リ ) 間で高スループッ トのデータ  パスを実現す
るこ とです。 HP スレーブ ポートは、 64 ビッ ト または 32 ビッ トのインターフェイスにコンフ ィギュレーシ ョ ン可能
です。
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こ こでは、AXI CDMA IP をファブリ ッ クのマスターと して使用してデザインを作成し、これを  PS の HP 64 ビッ ト  ス
レーブ ポートに統合します。 図 6-1 にシステムのブロ ッ ク図を示します。

このシステムは、 次のよ うに接続されています。

1. AXI CDMA スレーブ ポートは、 PS の汎用マスター ポート  1 (M_AXI_GP1) に接続されます。 PS CPU はこれを利
用してデータ転送用の AXI CDMA レジスタ  セッ ト をコンフ ィギュレーシ ョ ンし、そのステータスを確認します。

2. AXI CDMA マスター ポートは、 PS の高性能 (HP) スレーブ ポート  0 (S_AXI_HP0) に接続されます。 AXI CDMA
はこれを利用して DDR システム メモ リからデータを読み出します。 これは、 CDMA のデータ転送中は転送元
バッファー位置となり ます。

3. AXI CDMA マスター ポートは PS の高性能 (HP) スレーブ ポート  2 (S_AXI_HP2) に接続されます。AXI CDMA は
これを利用して DDR システム メモ リにデータを書き込みます。 これは、 CDMA のデータ転送中は転送先バッ
ファー位置となり ます。

4. AXI CDMA の割り込みは、 ファブリ ッ クから  PS の割り込みコン ト ローラーへ接続されます。 データの転送後、
またはデータ  ト ランザクシ ョ ン中のエラー発生時に、 AXI CDMA の割り込みが開始します。

このシステムでは、 HP のスレーブ ポート  0 を 0x20000000 ～ 0x2FFFFFFF 範囲の DDR メモ リ位置にアクセスす
るよ うにコンフ ィギュレーシ ョ ンします。 DDR システム メモ リのこの位置は、 CDMA がデータを読み出す転送元
バッファー位置となり ます。

さ らに、 ユーザーは HP スレーブ ポート  2 を 0x30000000 ～ 0x3FFFFFFF  範囲の DDR メモ リ位置にアクセスする
よ うにコンフ ィギュレーシ ョ ンします。 DDR システム メモ リのこの位置は、 CDMA がデータを書き込む転送先の位
置となり ます。

データ転送チャネルの AXI CDMA IP データ幅を、最大バース ト長を 256 と した 1024 ビッ トにコンフ ィギュレーシ ョ
ンします。 この設定によ り、 CDMA の最大転送サイズは各ト ランザクシ ョ ンにつき  1024x256 ビッ ト とな り ます。

上記のシステム向けにアプリ ケーシ ョ ン ソフ ト ウェア コードを記述します。このコードを実行する と、指定したデー
タ  パターンで転送元バッファー メモ リが初期化され、 転送先バッファー メモ リはすべてゼロが書き込まれてク リ ア
されます。 次に、 DMA 転送向けに CDMA レジスタのコンフ ィギュレーシ ョ ンを開始します。 転送元バッファー位

X-Ref Target - Figure 6-1

図 6-1 : ブロック図
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置、転送先バッファー位置、および CDMA レジスタへ転送されるバイ トの数を書き込んで CDMA 割り込みを待機し
ます。 割り込みが発生する と、 DMA 転送のステータスを確認します。

データ転送のステータスが正常の場合、 転送元バッファー データ と転送先バッファー データを比較してシ リ アル
ターミナルにその結果を表示します。

データ転送のステータスがエラーの場合、 シ リ アル ターミナルにエラー ステータスを表示して実行を停止します。

6.1.1 チュート リアル : AXI CDMA を  PS の HP スレーブ ポート と
統合する

1. 次のいずれかから開始します。

° 22 ページの 「チュート リ アル : ファブリ ッ クでインスタンシエート される  IP の機能を確認する」 で作成し
たシステムを使用します。

° 10 ページの「チュート リ アル : Zynq プロセッシング システムの新規エンベデッ ド  プロジェク ト を作成する」
の説明に従って新しいプロジェク ト を作成します。

2. PlanAhead ツールの [Sources] ペインで [system_i-system(system.xmp)] をダブルク リ ッ ク し、 XPS を起動します。

3. [XPS System Assembly] ビューで [Bus Interfaces] タブをク リ ッ ク します。

4. IP カタログで [DMA and Timer] を展開し、 [AXI Central DMA] をダブルク リ ッ ク して追加します。

axi_cdma 3.04.a IP インスタンスをデザインに追加するかど うかを確認する メ ッセージが表示されます。

5. [Yes] をク リ ッ ク します。

CDMA のコンフ ィギュレーシ ョ ン ウ ィンド ウが開きます。

6. [CDMA Configuration] ウ ィンド ウで [User] タブをク リ ッ ク します。データ転送チャネル オプシ ョ ンのデータ幅を
1024 に、 オプシ ョ ンを使用するための最大バース ト長を 256 に変更します。

7. [OK] をク リ ッ ク します。

「axi_cdma IP with version number 3.03.a is instantiated with the name axi_cdma_0」 と表示されたメ ッセージ ウ ィンド
ウが開きます。 XPS によって、 接続先のプロセッサを決定するよ うに求められます。 

8. [User will make necessary connections and settings] を選択します。

注記 : この設定では、 AXI CDMA を手動で接続するこ とが必要になり ます。

9. [OK] をク リ ッ ク します。

未接続の axi_cdma_0 IP がデザインでインスタンシエート されます。 ク ロスチェッ クするために、 [XPS System
Assembly] ビューの [Bus Interfaces] タブをク リ ッ ク します。 リ ス トで未接続の axi_cdma_0 が検出されます。 

10. IP カタログで [Bus and Bridge] を展開し、 [AXI Interconnect IP] をダブルク リ ッ ク して追加します。

axi_interconnect 1.06.a IP インスタンスをデザインに追加するかど うかを確認するダイアログ ボッ クスが開きま
す。

11. [Yes] をク リ ッ ク します。

AXI インターコネク トのコンフ ィギュレーシ ョ ン ウ ィンド ウが開きます。コンポーネン トのインスタンス名と し
て 「axi_interconnect_gp1」 と入力します。

12. [OK] をク リ ッ ク します。

XPS によって未接続の AXI インターコネク ト  IP、 axi_interconnect_gp1 がシステムへ追加されます。 ク ロ
スチェッ クするために、 [XPS System Assemblyify] ビューの [Bus Interface] タブをク リ ッ ク します。
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注記 : この章の後半では、このインターコネク ト を用いて AXI CDMA スレーブ ポート と  PS の GP マスター ポー
ト  1 を接続します。 このインターフェイスを利用し、 PS CPU から設定された CDMA レジスタをコンフ ィギュ
レーシ ョ ンします。

13. 前述の 3 つの手順を繰り返し、さ らに axi_interconnect_hp という インスタンス名の AXI インターコネク ト
IP をも う  1 つ追加します。

注記 : この章の後半では、 このインターコネク ト を用いて AXI CDMA マスター ポートおよび PS HP スレーブ
ポート  0 とポート  2 を接続します。 そして、 このインターフェイスを使用してデータを転送元から転送先 DDR
メモ リ位置へコピーします。

14. [XPS System Assembly] ビューで [Zynq] タブをク リ ッ ク し、Zynq プロセッシング システムのブロ ッ ク図を開きま
す。

15. 緑色の [32b GP AXI Master Port] ブロ ッ クをク リ ッ ク して processing_system7_0 Configuration ウ ィザードを開きま
す。

16. [User] タブで [General Purpose Master AXI Interface] を展開し、 [Enable M_AXI_GP1 Interface] をオンにします。

17. [OK] をク リ ッ ク し、 PS とファブ リ ッ ク間の GP マスター ポート  1 インターフェイスを有効にします。

18. Zynq プロセッシング システムのブロ ッ ク図で、緑色の [high performance AXI 32/64b Slave Ports] ブロ ッ クをク リ ッ
ク して processing_system7_0 Configuration ウ ィザードを開きます。

19. [User] タブで [High Performance Slave AXI Interface] を展開し、 次のよ うに設定します。 

a. [Enable S_AXI_HP0 interface] をオンにし、PS とファブ リ ッ ク間の HP スレーブ ポート  0 インターフェイスを
有効にします。

b. HP0 ベース  アドレスを  0x20000000 に、 HP0 上位アドレスを 0x2FFFFFFF に変更します。

これによ り、 HP スレーブ ポート  0 が 0x20000000 ～ 0x2FFFFFFF の DDR システム メモ リへアクセスす
るよ うに設定されます。 これは、 CDMA がデータを読み出す転送元バッファー位置となり ます。

c. [Enable S_AXI_HP2 interface] をオンにし、PS とファブ リ ッ ク間の HP スレーブ ポート  2 インターフェイスを
有効にします。

http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 53
UG873 (v14.6) 2013 年 6 月 19 日

AXI CDMA を  Zynq PS の HP スレーブ ポート と  統合する

d. HP2 ベース  アドレスを  0x30000000 に、 HP2 上位アドレスを 0x3FFFFFFF に変更します。

これによ り、 HP スレーブ ポート  2 が 0x30000000 ～ 0x3FFFFFFF の DDR システム メモ リへアクセスす
るよ うに設定されます。 これは、 CDMA がデータを書き込む転送先の位置となり ます。

注記 : デフォルトでは、HP スレーブ ポートは 64 ビッ ト  インターフェイスにコンフ ィギュレーシ ョ ンされて
います。

e. [OK] をク リ ッ ク します。

20. [Bus Interfaces] タブをク リ ッ ク し、 次のよ うに接続します。

a. [processing_system7_0] の下にある  [M_AXI_GP1] をク リ ッ ク し、 [Bus Name] 列で [No Connection] をク
リ ッ ク します。表示される ド ロ ップダウン リ ス トで [M_AXI_GP1] を [axi_interconnect_gp1] に接続
します。

b. [processing_system7_0] を非展開にします。

c. [axi_cdma_0] の下にある  [S_AXI_LITE] をク リ ッ ク し、 [Bus Name] 列で [No Connection] をク リ ッ ク して
[Connection] ダイアログ ボッ クスを開きます。

X-Ref Target - Figure 6-2

図 6-2 : [XPS Core Configuration] ウィンドウの設定
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d. [Select AXI Interconnect] リ ス トで [axi_interconnect_gp1] を選択します。

[processing_system7_0.M_AXI_GP1] が [Select Master(s)] リ ス トに表示されているこ とを確認します。
[processing_system7_0.M_AXI_GP1] をオンにします。

e. [OK] をク リ ッ ク します。

XPS によって、 axi_cdma_0 スレーブ ポー ト  インターフェ イ スは axi_interconnect_gp1 を介して
processing_system7_0 GP マスター ポート  1 インターフェイスへ接続されます。

f. [axi_cdma_0] で [M_AXI] を選択し、 [Bus Name] 列では [No Connection] を選択します。表示される ド ロ ッ
プダウン リ ス トで [M_AXI] を [axi_interconnect_hp] に接続します。

g. [processing_system7_0] を展開して [S_AXI_HP0] をク リ ッ ク します。 [Bus Name] 列で [No Connection]
をク リ ッ ク し、 [Connection] ダイアログ ボッ クスを開きます。

h. [Select AXI Interconnect] リ ス トで [axi_interconnect_hp] を選択します。

[axi_cdma_0.M_AXI] が [Select Master(s)] リ ス トに表示されているこ とを確認します。 [axi_cdma_0.M_AXI]
をオンにします。

i. [OK] をク リ ッ ク します。

XPS によって、axi_cdma_0 マスター ポートは axi_interconnect_hp を介してprocessing_system7_0
HP スレーブ ポート  0 へ接続されます。

j. 前述の 3 つの手順を繰り返し、 axi_cdma_0 マスター ポート を axi_interconnect_hp を介して
processing_system7_0 HP スレーブ ポート  2 へ接続します。

X-Ref Target - Figure 6-3

図 6-3 : [AXI Connection] ダイアログ ボックス

X-Ref Target - Figure 6-4

図 6-4 : [Ports] タブ
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21. IP およびそれらのポートが リ ス ト されている  [Ports] タブをク リ ッ ク します。 [axi_interconnect_gp1]、
[axi_interconnect_hp]、 および [axi_cdma_0] を展開します。

22. 次の IP の接続を確認します。 これらの中で接続されていないものがあれば、 こ こで接続します。

[Ports] タブの内容が図 6-5 のよ うになるよ うにします。

23. すべての IP を非展開にし、 [processing_system7_0] を展開します。 次のよ うにポートが接続されていない
場合は、 こ こで接続します。 図 6-6 のよ うに接続します。

表 6-1 : IP 接続

IP ポート 接続

axi_interconnect_gp1 INTERCONNECT_ACLK processing_system7_0 :FCLK_CLK0

INTERCONNECT_ARESETN processing_system7_0::FCLK_RESET0_N

axi_interconnect_hp INTERCONNECT_ACLK processing_system7_0 :FCLK_CLK0

INTERCONNECT_ARESETN processing_system7_0::FCLK_RESET0_N

axi_cdma_0 (BUS_IF) S_AXI_LITE::s_axi_lite_aclk processing_system7_0 :FCLK_CLK0

(BUS_IF) M_AXI:: m_axi_aclk processing_system7_0 :FCLK_CLK0

X-Ref Target - Figure 6-5

図 6-5 : 完成したポート接続

表 6-2 : Processing_system7_0 ポートの接続

IP ポート 接続

Processing_system7_0 (BUS_IF) M_AXI_GP1::M_AXI_GP1_ACLK processing_system7_0 :FCLK_CLK0

(BUS_IF) S_AXI_HP0::S_AXI_HP0_ACLK processing_system7_0 ::FCLK_CLK0

(BUS_IF) S_AXI_HP2::S_AXI_HP2_ACLK processing_system7_0 ::FCLK_CLK0
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24. 次の手順に従って、 ファブ リ ッ ク側の CDMA 割り込みを PS 側の割り込みコン ト ローラーへ接続します。

a. [Processing_System7_0] の [Connected Port] 列で [1L to H:No Connection] をク リ ッ ク します。

注記 : 第 3 章で作成したシステムを変更する場合、 
[Connected Port] タブの [L to H : axi_timer_0_interrupt] を選択します。

[Interrupt Connection] ダイアログ ボッ クスが開きます。

b. [Unconnected Interrupts] リ ス トで [axi_cdma_0] を選択し、矢印をク リ ッ ク して選択したアイテムを  [Connected
Interrupts] リ ス トへ移動させます。

c. [OK] をク リ ッ ク します。

XPS でファブリ ッ ク側の CDMA 割り込みが PS の割り込みコン ト ローラーへ接続されます。

25. [Addresses] タブをク リ ッ ク し、 [Generate Addresses]  をク リ ッ ク してマップされていないデバイスのアドレ
スを生成します。

[axi_cdma_0] が [processing_system7_0] アド レス範囲内のアド レスに割り当てられている こ と を確認し
ます。

26. processing_system7_0 のアドレス  マップで、 axi_cdma_0 ベース  アドレスを 0x80200000 に、 上位アドレスを
0x8020FFFF に変更します。

これによ り、axi_cdma_0 のアドレス範囲が、確実に processing_system7_0 アドレス空間内の 0x80200000
～ 0x8020FFFF に固定されます。

27. デザイン ルール チェッ クを実行します。 コンソールにエラーがないこ とを確認します。

28. XPS を閉じます。 PlanAhead™ デザイン ツール ウ ィンド ウが再度アクティブになり ます。

X-Ref Target - Figure 6-6

図 6-6 : Processing_system7_0 の接続
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29. [Design Sources] でエンベデッ ド  ソースをク リ ッ ク してから右ク リ ッ ク し、 [Create Top HDL] をク リ ッ ク します。
PlanAhead ツールによって system_stub.v ファ イルが生成されます。

30. 変更したファイルをすべて保存します。

31. [Flow Navigator] の [Program and Debug] リ ス トで [Generate Bitstream] を選択します。PlanAhead が生成するすべて
の警告メ ッセージを無視します。

32. ビッ ト ス ト リームの生成が完了したら、 第 2 章の説明に従ってハード ウェアをエクスポート して SDK を起動し
ます。 このデザインについては、 PL ファブ リ ッ ク用に生成されたビッ ト ス ト リームがあるため、 これも  SDK へ
エクスポート されます。

6.2 デザイン用のスタンドアロン  アプリケーシ ョ ン  
ソフ トウェア 
この章で設計した CDMA ベースのシステムをボードで実行するには、 アプ リ ケーシ ョ ン ソフ ト ウェアが必要です。
こ こでは、 CDMA ベースのスタンドアロン アプリ ケーシ ョ ン ソフ ト ウェアについて詳細に説明します。

アプ リ ケーシ ョ ン ソフ ト ウェアの main() 関数は、 実行のエン ト リ  ポイン トです。 これは、 指定したテス ト  パター
ンで転送元メモ リ  バッファーを初期化し、 転送先メモ リ  バッファーにすべてゼロを書き込むこ とでこれをク リ アし
ます。

次に、 アプ リ ケーシ ョ ン ソフ ト ウェアは、 転送元バッファーおよび転送先バッファーの開始位置を提供して CDMA
レジスタ  セッ ト をコンフ ィギュレーシ ョ ンします。 DMA 転送を開始するために、 CDMA レジスタで転送されるバイ
ト数を書き込み、 CDMA の割り込みが発生するのを待機します。 割り込み後、 DMA 転送のステータスを確認し、 転
送元バッファーを転送先バッファーと比較します。最後に、シ リ アル ターミナルにその比較結果を出力し、実行を停
止します。

6.2.1 アプリケーシ ョ ン  ソフ トウェアのフロー

アプリ ケーシ ョ ン ソフ ト ウェアは次を実行します。

1. 転送元バッファーを指定したテス ト  パターンで初期化します。 転送元バッファー位置は 0x20000000 ～
0x2FFFFFFF の範囲です。

転送先バッファーにすべてゼロを書き込むこ とでこれをク リ アします。転送先バッファー位置は、 0x30000000
～ 0x3FFFFFFF の範囲です。

2. XI CDMA IP を初期化して次を実行します。

a. CDMA コールバッ ク関数を AXI CDMA ISR と関連付け、 割り込みを有効にします。

このコールバッ ク関数は CDMA の割り込み中に実行されます。 これは、 DMA 転送のステータスに応じて割
り込み Done/Error フラグを設定します。

アプ リ ケーシ ョ ン ソフ ト ウェアは、コールバッ ク関数がこれらのフラグを設定するまで待機し、そのステー
タス  フラグに応じて実行します。

b. CDMA をシンプル モードでコンフ ィギュレーシ ョ ンします。

c. CDMA IP のステータス  レジスタを確認して CDMA アイ ドル ステータスを検証します。

d. 転送元のバッファー開始位置 0x20000000 を CDMA レジスタに設定します。

e. 転送先のバッファー開始位置 0x30000000 を CDMA レジスタに設定します。

f. CDMA レジスタへ転送するバイ ト数を設定します。 アプ リ ケーシ ョ ン ソフ ト ウェアは DMA 転送を開始し
ます。
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3. CDMA 割り込みがト リガーされた後、 DMA 転送のステータスを確認します。

転送のステータスが正常の場合、アプリ ケーシ ョ ン ソフ ト ウェアは転送元バッファー位置と転送先バッファー位
置を比較し、 シ リ アル ターミナルにその結果を表示して実行を終了します。 

転送のステータスがエラーの場合、 ソフ ト ウェアはシ リ アル ターミナルにエラー ステータスを出力し、 実行を
停止します。

6.2.2 チュート リアル : SDK を使用してスタンドアロンの 
CDMA アプリケーシ ョ ンを実行する

1. SDK が開かれていない場合は、 こ こで開きます。

2. TCF (Target Communication Frame) (hw_server.exe) エージェン トが Windows マシンで実行中であるこ とを確認しま
す。 実行中でない場合は、 SDK で [Xilinx Tool] → [Launch Hardware Server] をク リ ッ ク します。

3. SDK で [File] → [New] → [Xilinx C Project] をク リ ッ ク します。

New Project ウ ィザードが開きます。

4. 次の表の情報に基づいて、 ウ ィザード画面で選択操作を行います。

5. [Finish] をク リ ッ ク します。

New Project ウ ィザードが閉じ、SDK によって cdma_app アプリ ケーシ ョ ン プロジェク トおよび cdma_app_bsp BSP
プロジェク トが [Project Explorer] の下に作成されます。また、自動的にこのプロジェク トがコンパイルされて BSP
が生成されます。

注記 : SDK で 「arm-xilinx-eabi-gcc: command not found」 とい う エラー メ ッセージが返された場合は、 アンサー
53306 を参照してください。

6. [Project Explorer] タブで [cdma_app] プロジェク ト を展開して [src] ディ レク ト リ を右ク リ ッ ク し、[Import] をク
リ ッ ク して [Import] ダイアログ ボッ クスを開きます。

7. [Import] ダイアログ ボッ クスで [General] を展開し、 [File System] をク リ ッ ク します。

8. [Next] をク リ ッ ク します。

9. cdma_app.c ファ イルを追加して [Finish] をク リ ッ ク します。

SDK は自動的にアプリ ケーシ ョ ンを構築し、 コンソール ウ ィンド ウにステータスを表示します。

注記 : システムのアプリ ケーシ ョ ン ソフ ト ウェアのファ イル名は cdma_app.c です。 このファ イルは、 このガ
イ ドで提供されている  ug873-design-files.zip から入手できます。この ZIP ファ イルへのリ ンクは、付録 A
「その他のリ ソース」 に記載されています。

ウィザード画面 システム プロパティ 使用する設定コマンド

Application Project

Project Name cdma_app

Use Default Location このオプシ ョ ンをオンにする。

Hardware Platform system_hw_platform

Processor PS7_cortexa9_0

OS Platform スタンドアロン

Language C

Board Support Package [Create New] をク リ ッ ク して 「cdma_app_bsp」
とい う名前を付ける。

Templates Available Templates 空のアプリ ケーシ ョ ン

http://japan.xilinx.com/support/answers/53306.htm
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10. ボー レート を 115200 に設定したシ リ アル通信ユーティ リ ティ を開きます。

11. ハードウェア ボードがセッ ト アップされ、 オンになっているこ とを確認します。

注記 : ボードのセッ ト  アップは、 「2.1.3 チュート リ アル : Hello World アプリ ケーシ ョ ンを実行する」 を参照して
ください。

12. SDK で [Xilinx Tools] → [Program FPGA] をク リ ッ ク し、 [Program FPGA] ダイアログ ボッ クスを開きます。ダイア
ログ ボッ クスにはビッ ト ス ト リーム パスが表示されます。

13. [Program] をク リ ッ ク し、 ビッ ト ス ト リームをダウンロード して PL ファブ リ ッ クをプログラムします。

14. 「2.1.3 チュート リ アル : Hello World アプリ ケーシ ョ ンを実行する」 の手順と同じよ うにプロジェク ト を実行しま
す。

15. シ リアル ターミナルで CDMA 転送のステータスを確認します。転送が正常の場合、「DMA Transfer is Successful」
とい う メ ッセージが表示されます。 エラーの場合、 シ リ アル ターミナルにエラー メ ッセージが表示されます。

6.3 CDMA システム向けの Linux OS ベースの
アプリケーシ ョ ン  ソフ トウェア 
このセクシ ョ ンでは、Linux で提供される  mmap() システム コールを使用して CDMA 向けの Linux ベース  アプリ ケー
シ ョ ン ソフ ト ウェアを作成し、 これをハード ウェアで実行して CDMA IP の機能を確認します。 

メモ リのマップ中に提供される属性に応じて読み出しまたは書き込みができるよ うに、mmap() システム コールを使
用して指定したカーネル メモ リ領域をユーザー層に割り当てます。 mmap() システム コールの詳細は、 このガイ ド
では割愛します。

注意 : mmap() Linux アプリ ケーシ ョ ンの書き込みに推奨する方法ではあ り ません。カーネルの一部の制限領域または
共有リ ソースへ間違ってアクセスする と、 カーネルがク ラ ッシュする可能性があ り ます。

アプ リ ケーシ ョ ン ソフ ト ウェアの main() 関数は、 実行のエン ト リ  ポイン トです。 これは、 指定したテス ト  パター
ンで転送元アレイを初期化し、 転送先アレイをク リ アします。 その後、 転送元アレイの内容を 0x20000000 から開
始する  DDR メモ リへコピーし、転送先への DMA 転送を開始するよ うに DMA レジスタを設定します。DMA 転送後、
アプ リ ケーシ ョ ンは転送のステータスを読み出し、 その結果をシ リ アル ターミナルに表示します。

6.3.1 アプリケーシ ョ ン  ソフ トウェアの構成手順

アプリ ケーシ ョ ン ソフ ト ウェアは次の手順で構成されます。

1. 0xA5A5A5A5 値を持つユーザー層にある転送元アレイ全体を初期化します。

ユーザー層にある転送先バッファー全体にすべてゼロを書き込むこ とでこれをク リ アします。

2. 0x20000000 から開始するカーネルのメモ リ位置を、 mmap() システム コールを使用して書き込み許可を持つ
ユーザー層にマップします。

このよ うにマップするこ とで、 指定したカーネル メモ リへの書き込みが可能になり ます。

3. 転送元アレイの内容をマップ済みのカーネル メモ リへコピーします。

4. ユーザー層からカーネル メモ リ をアンマップします。

5. AXI CDMA レジスタのメモ リ位置を、 mmap() システム コールを使用して読み出し許可および書き込み許可を
持つユーザー層にマップします。 ユーザー層から  CDMA レジスタを次のよ うに設定します。

a. DMA を リセッ ト して前の通信を停止します。
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b. 割り込みを有効にして DMA 転送のステータスを取得します。

c. CDMA をシンプル モードで設定します。

d. CDMA がアイ ドル状態であるこ とを確認します。

e. 転送元バッファーの開始位置 0x20000000 を CDMA レジスタに設定します。

f. 転送先バッファーの開始位置 0x30000000 を CDMA レジスタに設定します。

g. CDMA レジスタで転送されるバイ ト数を設定します。このレジスタへの書き込みによ り  DMA 転送を開始し
ます。

6. DMA 転送のステータスを、 転送が終了するまで継続して読み出します。

7. CDMA 転送の終了後、 mumap() システム コールを使用するユーザー層からの変更に備え、 CDMA レジスタ  メ
モ リ をアンマップします。

8. 0x30000000 から開始するカーネル メモ リ位置を、 読み出し属性と書き込み属性を備えるユーザー層にマップ
します。

9. 0x30000000 から開始するカーネル メモ リの内容をユーザー層の転送先アレイにコピーします。

10. ユーザー層からカーネル メモ リ をアンマップします。

11. 転転送元アレイを転送先アレイ と比較します。

12. シ リアル ターミナルに比較結果が表示されます。 比較結果が正常の場合、 「DATA Transfer is Successful」 とい う
メ ッセージが表示されます。 エラーの場合、 シ リ アル ターミナルにエラー メ ッセージが表示されます。

6.4 チュート リアル : SDK を使用して Linux 
CDMA アプリケーシ ョ ンを実行する
Linux OS ベースのアプリ ケーシ ョ ンを実行する手順は次のとおりです。

1. 「ターゲッ ト  ボートで Linux をブートする」

2. 「SDK を使用し、 アプ リ ケーシ ョ ンを構築してそれをターゲッ ト  ボードで実行する」

6.4.1 ターゲッ ト  ボートで Linux をブートする

第 5 章「SDK を使用した Linux のブートおよび アプリ ケーシ ョ ンのデバッグ」の説明に従って、Zynq ZC702 ターゲッ
ト  ボードで Linux をブート します。

ブートが完了する と、 zynq> プロンプ トがシ リ アル ターミナルに表示されます。 13の手順 「5.2.3 チュート リ アル :
JTAG モードで Linux をブートする」 の説明に従って、 ボードの IP アドレスを設定します。

6.4.2 SDK を使用し、 アプリケーシ ョ ンを構築してそれをター
ゲッ ト  ボードで実行する

1. 2の手順 「5.2.4 チュート リ アル : SDK リモート  デバッグを使用して Linux アプリ ケーシ ョ ンをデバッグする」 に
従って、 Windows マシンをホス ト と してセッ ト  アップします。

2. SDK で [Xilinx Tools] → [Program FPGA] をク リ ッ ク し、 ビッ ト ス ト リーム パスが表示される  [Program FPGA] ダ
イアログ ボッ クスを開きます。

3. [Program] をク リ ッ ク し、 ビッ ト ス ト リームをダウンロード して PL ファブ リ ッ クをプログラムします。

注記 : Zync PS は一時停止状態にあ り、 Zync Linux ターミナル上に応答はあ り ません。 Zync の再開については、
アンサー 55150 を参照してください。

http://xkb/pages/55150.aspx
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http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 61
UG873 (v14.6) 2013 年 6 月 19 日

チュート リアル : SDK を使用して Linux CDMA アプリケーシ ョ ンを実行する

4. [File] → [New] → [Application Project] をク リ ッ ク します。

5. 次の表の情報に基づいて、 ウ ィザード画面で選択操作を行います。

6. [Finish] をク リ ッ ク します。

New Project ウ ィザードが閉じ、 SDK によって Linux_blinkled_app プロジェク トが [Project Explorer] の下に作成さ
れます。

7. [Project Explorer] タブで [linux_cdma_app] プロジェク ト を展開して [src] ディ レク ト リ を右ク リ ッ ク し、
[Import] をク リ ッ ク して [Import] ダイアログ ボッ クスを開きます。

8. [Import] ダイアログ ボッ クスで [General] を展開し、 [File System] をク リ ッ ク します。

9. [Next] をク リ ッ ク します。

10. linux_cdma_app.c ファ イルを追加して [Finish] をク リ ッ ク します。

SDK は自動的にアプリ ケーシ ョ ンを構築し、 linux_cdma_app.elf ファ イルを生成します。 コンソール ウ ィ
ンド ウでステータスを確認します。

注記 : システムのアプリ ケーシ ョ ン ソフ ト ウェア ファ イル名は linux_cdma_app.c です。このファイルは、こ
のガイ ドで提供されている  ug873-design-files.zip から入手できます。 この ZIP ファ イルへの リ ンクは、
付録 A 「その他のリ ソース」 に記載されています。

11. [linux_cdma_app] を右ク リ ッ ク し、 [Run As] → [Run Configurations] をク リ ッ ク して Run Configuration ウ ィ
ザードを開きます。

12. Run Configuration ウ ィザードで [Remote ARM Linux Application] を右ク リ ッ ク し、 [New] をク リ ッ ク します。

13. [Connection] ド ロ ップダウン リ ス トで [New] を選択し、 New Connection ウ ィザードを開きます。

14. [SSH Only] タブをク リ ッ ク して [Next] をク リ ッ ク します。

15. [Host Name] タブでターゲッ ト  ボード  IP を入力します。

注記 : ターゲッ ト  IP を確認するには、 シ リ アル ターミナルの Zynq> プロンプ トで 「ipconfig eth0」 と入力しま
す。 ボードに割り当てられているターゲッ ト  IP がシ リ アル ターミナルに表示されます。

16. 接続の名前および説明を、 それぞれに対応するタブで設定します。

17. [Finish] をク リ ッ ク して接続を作成します。

18. Run Configuration ウ ィザードでは、[Remote Absolute File Path for C/C++ Application] の下にある  [Browse]  をク リ ッ
ク します。 Select Remote C/C++ Application File ウ ィザードが開きます。

19. 次を実行します。

a. ルート  ディレク ト リ を展開します。 Enter Password ウ ィザードが開きます。

b. ユーザー ID およびパスワード  (root/root) を入力し、 [Save ID] および [Save Password] をオンにします。

c. [OK] をク リ ッ ク します。

Windows ホス ト  マシン と ターゲッ ト  ボード間の接続がすでに確立されているため、 ウ ィ ン ド ウにルー ト
ディ レク ト リの内容が表示されます。

ウィザード画面 システム プロパティ 使用する設定コマンド

Application Project

Project Name Linux_cdma_app

Hardware Platform system_hw_platform

Processor PS7_cortexa9_0

OS Platform Linux

Language C

Templates Available Templates Linux の空のアプリ ケーシ ョ ン
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d. パス名の 「/」 で右ク リ ッ ク し、 新しいフォルダーを 「Apps」 とい う名前で作成します。

e. /Apps/linux_cdma_app.elf などのアプリ ケーシ ョ ンへの絶対パスを提供します。

20. [Apply] をク リ ッ ク します。

21. [Run] をク リ ッ ク してアプ リ ケーシ ョ ンの実行を開始します。

22. シ リアル ターミナルで CDMA 転送のステータスを確認します。転送が正常の場合、「DMA Transfer is Successful」
とい う メ ッセージが表示されます。 エラーの場合、 シ リ アル ターミナルにエラー メ ッセージが表示されます。

23. Linux アプリ ケーシ ョ ンのデバッグ終了後、 SDK を閉じます。
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第 7 章

SDK を使用したソフトウェア プロファイル
この章では、 第 6 章で作成したスタンドアロン BSP と  AXI CDMA 関連のアプリ ケーシ ョ ンに対応するプロファ イル
機能を有効にします。

7.1 SDK を使用したアプリケーションのプロファイル 
プロファイルは、 各ルーチンにおけるソフ ト ウェアの実行時間を決定する方法です。 この情報を用いて、 コードの重
要な部分、およびデザインでの最適なコード配置を判断できます。頻繁に呼び出されるルーチンは、キャ ッシュ  メモ
リ など高速メモ リに配置するのが最適です。 プロファ イル情報を用いるこ とで、 コードをハード ウェアに配置可能か
ど うかも判断でき、 その結果全体的な性能が向上します。

7.1.1 チュート リアル : SDK でアプリケーシ ョ ン  ソフ ト
ウェアをプロファイルする

1. ザイ リ ンクスの SDK を起動し、 第 2 章および第 3 章で使用したワークスペース と同じものを開きます。

2. シ リアル ターミナルが開かない場合は、 ボー レート を 115200 に設定したシ リ アル通信ユーティ リ ティ を開き
ます。

3. SDK で [File] → [New] → [Xilinx C Project] をク リ ッ ク します。

New Project ウ ィザードが開きます。

4. 次の表の情報に基づいて、 ウ ィザード画面で選択操作を行います。

5. [Finish] をク リ ッ ク します。

ウィザード画面 システム プロパティ 使用する設定コマンド

Application Project

Project Name cdma_app_profile

Use Default Location このオプシ ョ ンをオンにする。

Hardware Platform system_hw_platform

Processor PS7_cortexa9_0

OS Platform スタンドアロン

Language C

Board Support Package
[Create New] をク リ ッ ク して

「cdma_app_profile_bsp」 とい う名前を付
ける。

Templates Available Templates 空のアプリ ケーシ ョ ン
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New Project ウ ィザードが閉じ、SDK によって cdma_app アプリ ケーシ ョ ン プロジェク トおよび cdma_app_bsp BSP
プロジェク トが [Project Explorer] の下に作成されます。 また、 自動的に BSP が生成されます。

6. [Project Explorer] タブで [cdma_app_profile] プロジェク ト を展開して [src] ディ レク ト リ を右ク リ ッ ク し、
[Import] をク リ ッ ク して [Import] ダイアログ ボッ クスを開きます。

7. [Import] ダイアログ ボッ クスで [General] を展開し、 [File System] をク リ ッ ク します。

8. [Next] をク リ ッ ク します。

9. cdma_app.c ファ イルを追加して [Finish] をク リ ッ ク します。

SDK は自動的にアプリ ケーシ ョ ンを構築し、 コンソール ウ ィンド ウにステータスを表示します。

注記 : システムのアプリ ケーシ ョ ン ソフ ト ウェアのファ イル名は cdma_app.c です。 このファ イルは、 このガ
イ ドで提供されている  ug873-design-files.zip から入手できます。この ZIP ファ イルへのリ ンクは、付録 A
「その他のリ ソース」 に記載されています。

10. [Project Explorer] タブで [cdma_app_profile_bsp] を右ク リ ッ ク し、 [Board Support Package Settings] をク リ ッ
ク して [Board Support Package Settings] ダイアログ ボッ クスを開きます。

11. [Board Support Package Settings] ダイアログ ボッ クスで、 左側のナビゲーシ ョ ン ペインにある  [standalone] をク
リ ッ ク します。 リ ス トの [enable_sw_intrusive_profiling] をオンにし、 その値を [true] に設定します。

この設定によ り、 ソフ ト ウェアの即効型 (intrusive) プロファ イルが有効になり ます。 このプロファ イル方法は評
価対象のプログラムにコードを埋め込むこ とで実現するため、 即効型と と らえらています。

X-Ref Target - Figure 7-1

図 7-1 : BSP 設定 : スタンドアロン  コンフ ィギュレーシ ョ ン
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12. [Board Support Package Settings] ダイアログ ボッ クスの左側のナビゲーシ ョ ン ペインで、 [drivers] の下にある
[cpu_cortexa9] を選択します。 [extra_compiler_flags] の設定で、 次のよ うに [Value] 列に 「-pg」 と入力します。

13. [OK] をク リ ッ ク します。

SDK は、 新しいプロファ イル オプシ ョ ンで再度 BSP の構築を開始します。

14. [Project Explorer] タブで、 [cdma_app_profile] を右ク リ ッ ク し、 [C/C++ Build] をク リ ッ ク して [Properties] ダイアロ
グ ボッ クスを開きます。

15. [Properties] ダイアログ ボッ クスが表示されたら、 [Tool Settings] タブをク リ ッ ク します。 [ARM gcc compiler] を展
開し、 [Profiling] をク リ ッ ク してから  [Enable Profiling (-pg)] をオンにします。

16. プロパティ  リ ス トで [Optimization] を選択し、 最適化レベルを None (-O0) に設定します。

17. プロパティ  リ ス トで [Debugging] を選択し、 デバッグ レベルを Default (-g) に設定します。

18. [OK] をク リ ッ ク します。

SDK はアプリ ケーシ ョ ンを再構築し、 cdma_app_profile.elf ファ イルを生成します。 コンソール ウ ィンド
ウでステータスを確認します。

7.1.2 チュート リアル : アプリケーシ ョ ンにプロファイル 
オプシ ョ ンを適用する

1. 「2.1.3 チュート リ アル : Hello World アプリ ケーシ ョ ンを実行する」の説明に従ってハード ウェア ボードがセッ ト
アップされ、 電源が投入されているこ とを確認してください。

2. SDK で [Xilinx Tools] → [Program FPGA] をク リ ッ ク し、 ビッ ト ス ト リーム パスが表示される  [Program FPGA] ダ
イアログ ボッ クスを開きます。

3. [Program] をク リ ッ ク し、 ビッ ト ス ト リームをダウンロード して PL ファブ リ ッ クをプログラムします。

4. [Project Explorer] タブで [cdma_app_profile] プロジェク ト を右ク リ ッ ク し、 [Run As] → [Run Configurations] をク
リ ッ ク して [Run Configuration] ダイアログ ボッ クスを開きます。

5. [Run Configuration] ダイアログ ボッ クスで、 [Xilinx C/C++ application (GDB)] をダブルク リ ッ ク して新しいコン
フ ィギュレーシ ョ ンを作成します。

6. [Profile Options] タブをク リ ッ ク し、 図 7-3 のよ うにパラ メーターを設定します。

a. [Enable Profiling] をオンにします。

X-Ref Target - Figure 7-2

図 7-2 : BSP 設定 : cup_cortexa9 の設定
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b. [Sampling Frequency (Hz)] を 10000 に設定します。

サンプ リ ング周波数は、どの関数がその時点で実行されているかをプロファ イル ルーチンが周期的に確認す
るために使用する割り込み間隔です。 このルーチンは、割り込みごとにプログラム カウンターを確認し、サ
ンプ リ ングを実行します。

c. [Histogram Bin Size (Words)] を 4 に設定します。

ヒ ス ト グラムのビンのサイズは、現時点で実行されている関数を判断するために使用されるプログラム カウ
ンター位置を確認する際の精度です。

d. スク ラ ッチ メモ リ  アドレスを 0x00300000 に設定します。

スク ラ ッチ メモ リ  アド レスは、 BSP プロファ イルがデータ収集に使用可能な DDR メモ リの位置を示しま
す。 アプ リ ケーシ ョ ン プログラムはこの空間を使用できません。

7. [Run] をク リ ッ ク してコンフ ィギュレーシ ョ ンを作成し、 実行します。 

8. [Reset Status] ダイアログ ボッ クスで [OK] をク リ ッ ク します。

プロファ イルが完了する と、 ダイアログ ボッ クスが開いて結果ファイルの位置が表示されます。

9. [OK] をク リ ッ ク します。

10. [Project Explorer] タブで [cdma_app_profile] の下にある  [Debug] フォルダーを展開し、 [gmon.out] をダブルク
リ ッ ク して [Gmon File Viewer] ダイアログ ボッ クスを開きます。

X-Ref Target - Figure 7-3

図 7-3 : プロファイルを有効にする

X-Ref Target - Figure 7-4

図 7-4 : [Gmon File Viewer] ダイアログ ボックス
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11. [OK] をク リ ッ ク し、 ウ ィンド ウの右側にある  [gprof] タブでプロファ イル結果 (gmon.out) を開きます。 図 7-5 の
よ うな表示になり ます。

X-Ref Target - Figure 7-5

図 7-5 :  gmon.out ファイルの表示
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アクセラレータ  コヒーレンシ ポート  (ACP)
プロセッシング システムの ACP はスヌープ制御ユニッ ト  (SCU) 上の AXI 準拠の 64 ビッ ト  スレーブ ポート  インター
フェイスで、プロセッサ ロジッ ク  (PL) とプロセシング システム (PS) の Cortex-A9 MP-Core プロセッサ システムを直
接接続し、 キャ ッシュ  コ ヒーレン ト な非同期アクセス  ポイン ト と して機能します。 ACP ポートの ト ランザクシ ョ ン
は、 コ ヒーレン ト または非コ ヒーレン ト とマークするこ とができます。 ファブ リ ッ ク側の AXI マスターは、 AXI バ
スに関連する信号を用いてコ ヒーレン ト な読み出し ト ランザクシ ョ ンを ARUSERS[0] と  ARCACHES[1] で、 書き込
みト ランザクシ ョ ンを AWUSERS[0] と  AWCACHES[1] で示します。 デバイスまたは厳し く順序付けられた ト ランザ
クシ ョ ンは常に非コ ヒーレン ト と して処理されます。

注記 : デバイスまたは厳し く順序付けられた ト ランザクシ ョ ンは、AXI マスター インターフェイスで生成されるタイ
プの転送です。 これらは、 非コ ヒーレン ト 、 かつバッファ リ ング不可のト ランザクシ ョ ンです。 固定サイズで決まっ
た数の ト ランザクシ ョ ンが常に生成されます。

8.1 はじめに
非コ ヒーレン ト な ト ランザクシ ョ ンは SCU を通過し、 変更されずに AXI マスター インターフェイスへ渡されます。
ACP スレーブのコ ヒーレン ト な AXI ト ランザクシ ョ ンは、一部の属性が適宜変更されて AXI マスター インターフェ
イスで増加または減少します。

コ ヒーレン ト な書き込み要求が外部のマスターから  ACP で受信される と、 SCU はコアの L1 データ  キャ ッシュでア
ドレスを確認します。存在する場合は、コ ヒーレンシ プロ ト コルがキャ ッシュの該当するラインをク リーニングして
無効化し、 ク リーニング後のデータを書き込み要求と結合させます。

外部マスターからコ ヒーレン ト なメモ リ領域への読み出し要求は、 SCU と関連する必要なデータがプロセッサの L1
キャ ッシュに格納されているかど うかを確認します。 L1 キャ ッシュに格納されている場合、 SCU はそのデータを要
求発行元のコンポーネン トに直接返します。 格納されていない場合、 L2 キャ ッシュ内を検索して最後にメ イン メモ
リにアクセスします。
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図 8-1 に、 AXI インターコネク ト を活用した AXI-4 準拠のマスターと  ACP 64 ビッ ト  ポート間の接続を示します。

8.2 ACP の要求
ACP に対して読み出しおよび書き込み要求を実行した場合の動作は、その要求がコ ヒーレン トかど うかによって次の
よ うに異なり ます。

8.2.1 コヒーレン トな ACP 読み出し要求

ARVALID と共に ARUSER[0] = 1 および ARCACHE[1] = 1 が送信された場合、 ACP の読み出し要求はコ ヒーレン
トです。 この場合、 SCU はコ ヒーレンシを維持します。データがいずれかの Cortex-A9 プロセッサにある場合、 PS コ
アはそのプロセッサからデータを直接読み出して ACP に返します。データがいずれの Cortex-A9 プロセッサにもない
場合、 ロ ッ ク されている属性を除くすべての AXI のパラ メーターと共に読み出し要求が L2 キャ ッシュまたはいずれ
の Cortex-A9 プロセッサ AXI マスター ポートのメ イン メモ リへ発行されます。

8.2.2 非コヒーレン トな ACP 読み出し要求

ARVALID と共に ARUSER[0] = 0 または ARCACHE[1] = 0 が送信された場合、 ACP の読み出し要求は非コ ヒーレ
ン トです。 この場合、 SCU はコ ヒーレンシを維持せず、読み出し要求はいずれか 1 つの SCU AXI マスター ポート  L2
キャ ッシュまたは OCM へ直接転送されます。

X-Ref Target - Figure 8-1

図 8-1 : AXI-4 準拠のマスターと  ACP 64 ビッ ト  ポート間の接続
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8.2.3 コヒーレン トな ACP 書き込み要求

AWVALID と一緒に AWUSER[0] = 1 および AWCACHE[1] = 1 が送信された場合、 ACP の書き込み要求はコ ヒーレ
ン トです。この場合、SCU はコ ヒーレンシを維持します。データがいずれかの Cortex-A9 プロセッサの L1 キャ ッシュ
にある場合、 PS のロジ ッ クは最初にその CPU のデータを ク リ ーニングして無効化し ます。 データがいずれの
Cortex-A9 プロセッサにもない場合、 または既にク リーニングと無効化が実行されている場合、 ロ ッ ク されている属
性を除くすべての AXI パラ メーターと共に書き込み要求が L2 キャ ッシュまたはいずれの Cortex-A9 プロセッサ AXI
マスター ポートのメ イン メモ リへ発行されますロ ッ ク されている属性を除く、 すべての AXI パラ メーターが提供さ
れます。

注記 : 書き込みパラ メーターの設定によっては、 ト ランザクシ ョ ンを L2 キャ ッシュに割り当てるこ と もできます。

8.2.4 非コヒーレン トな ACP 書き込み要求

AWVALID と共に AWUSER[0] = 1 または AWCACHE[1] = 0 が送信された場合、 ACP の書き込み要求は非コ ヒーレ
ン トです。 この場合、 SCU はコ ヒーレンシを維持せず、 書き込み要求はいずれか 1 つの SCU AXI マスター ポートに
直接転送されます。

8.3 ACP の制約
アクセラレータ  コ ヒーレンシ ポート  (ACP) には次の制約があ り ます。

• コ ヒーレン ト なメモ リへ排他的にアクセスできない

• コ ヒーレン ト なメモ リへロ ッ ク属性を有効にしてアクセスできない

• 長さ  = 3、サイズ = 3、および書き込みス ト ローブ ‡ 11111111 の書き込みト ランザクシ ョ ンを実行する と、CPU の
キャッシュ  ラインが破損する

• CP から  OCM へのアクセスを連続する と、 ほかの AXI マスターからのアクセスができなくなるこ とがある

ほかのマスターからアクセスできるよ うにするには、 ACP から  OCM への帯域幅を OCM の最大帯域幅よ り も小さ く
設定する必要があ り ます。 具体的には、 バース ト  サイズを 64 ビッ ト  ワード  x8 未満に抑えるこ とで可能です。

注記 : PS プロセッサ コアを使用する と、 3 番目の制約 (キャ ッシュ  ラインの破損) を検出できます。 

この IP を有効にする と、 キャ ッシュを破損する可能性のある ト ランザクシ ョ ンをザイ リ ンクス  ACP アダプターが監
視し、 書き込み要求発行元のマスターにエラー応答を返します。 書き込みト ランザクシ ョ ンは ACP インターフェイ
スに送信されるため、 キャ ッシュ破損の可能性は残り ますが、問題発生の可能性がマスターに通知されるので適切に
対処できます。 ACP アダプターには CPU への割り込み信号を生成する機能もあ り、 この信号をソフ ト ウェアで使用
して問題発生の可能性を検出できます。

ACP ポートの詳細は、 次の資料を参照して ください。 これらの資料へのリ ンクは、 付録 A 「その他のリ ソース」 に
記載されています。

• 『Zynq®-7000 AP SoC テクニカル リ ファレンス  マニュアル』 (UG585)

• 『The Effect and Technique of System Coherence in ARM Multicore Technology 』、 著者 : John Goodacre (Senior Program
Manager、 ARM Processor Division)

• 『ARM Cortex-A9 MPCore Technical Reference Manual』、 セクシ ョ ン 2.4 「Accelerator Coherency Port」
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Linux OS に対応する独自の IP および
デバイス ド ライバーを作成する

この章では、 Create and Import Peripheral (CIP) ウ ィザードを使用して IP を作成します。 また、 Zynq®-7000 AP SoC デ
バイス用に作成された IP を使用してシステムを開発します。

この IP 用に実行中のカーネルに動的にロード可能なモジュールと して Linux ベースのデバイス  ド ラ イバーを開発し
ます。

さ らに、 Zynq-7000 ZC702 ボード上のシステムで実行する  Linux ベースのアプリ ケーシ ョ ン ソフ ト ウェアを開発しま
す。

9.1 必要な環境
この章では、ターゲッ ト  プラ ッ ト フォームは ZC702 ボードを指します。ホス ト  プラ ッ ト フォームは ISE® Design Suite
ツールを実行する  Windows マシンのこ とです。

Linux ベースのデバイス  ド ラ イバーの開発およびカーネルのコンパイルに求められる要件は次のとおりです。

• Linux ベースのワークステーシ ョ ン : これを使用して IP 用にカーネルおよびデバイス  ド ラ イバーを構築します。

• CodeSourcery ツールチェーン : ターゲッ ト  アーキテクチャのクロス開発用に GNU ツールチェーンを導入した
Eclipse ベースの統合開発環境 (IDE) です。 ツールに関連する情報およびイ ン ス ト ールは、
http://wiki.xilinx.com/zynq-tools を参照してください。

• カーネル ソース  コードおよび構築環境 ( http://wiki.xilinx.com/zynq-linux) では、Zynq FPGA 固有の Linux カーネル
に関する詳細が提供されています。 カーネル ソース  ファ イルのダウンロードだけでな く、 Zynq FPGA 向けに
Linux カーネルを構築するための情報もこ こから入手できます.

注記 : 「xilinx-14.4-build」とい う タグが含まれたカーネル ソース  ファ イルと  U-Boot ファ イルを http://git.xilinx.com
からダウンロードできます。

• デバイス  ド ラ イバー ソフ ト ウェア ファ イル (blink.c) および対応するヘッダー ファ イル (blink.h) : これら
のファイルは、 このガイ ドで提供されている  ug873-design-files.zip から入手できます。

• アプリ ケーシ ョ ン ソフ ト ウェア (linux_blinkled_apps.c) および対応するヘッダー ファ イル (blink.h) :
これらのファイルは、 このガイ ドで提供されている  ug873-design-files.zip から入手できます。

• カーネルおよびデバイス  ド ラ イバーのコンパイルを省略したい場合は、このセクシ ョ ンで必要なコンパイル済み
のイ メージを使用してください。 これらのイ メージは、 ug873-design-files.zip から入手できます。

注記 : ug873-design-files.zip ファ イルへのリ ンクは、 付録 A 「その他のリ ソース」 に記載されています。

注意 : ペリ フェラル IP の LKM (Loadable Kernel Module) は、 ベース  カーネル イ メージを生成する同じカーネル構築
プロセスの一部と して構築する必要があ り ます。 カーネルまたは LKM 構築プロセスを省略したい場合は、 このセク
シ ョ ン向けにすでにコンパイルされているカーネルおよび LKM モジュール向けのイ メージを使用して ください
(ug873-design-files.zip から入手可能)。
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9.2 ペリフェラル IP の作成
このセクシ ョ ンでは、CIP ウ ィザードを使用して AXI4-Lite 準拠のスレーブ ペリ フェラル IP フレームワークを作成し
ます。 また、 このペリ フェラル IP フレームワークに機能およびポート割り当てを追加します。

作成するペリ フェラル IP は AXI4-Lite 準拠のスレーブ IP です。これには 28 ビッ ト  カウンターが含まれます。 このカ
ウンターの 4 MSB ビッ トは、ペリ フェラル IP の 4 つの出力ポート を駆動します。図 9-1 にこのブロ ッ ク図を示します。

上記のブロ ッ ク図に記載されているコンフ ィギュレーシ ョ ン レジスタの詳細は、 次のとおりです。

9.2.1  チュート リアル : ペリフェラル IP の作成

このセクシ ョ ンでは、 AXI4-lite 準拠のスレーブ ペリ フェラル IP を作成します。

1. 「2.1.1 チュート リ アル : Zynq プロセッシング システムの新規エンベデッ ド  プロジェク ト を作成する」 の説明に
従って新しいプロジェク ト を作成します。

2. ペリ フェラル IP を作成するには、 『EDK コンセプ ト、 ツール、 テクニッ ク』 (UG683) の次のセクシ ョ ンを参照し
てください。

X-Ref Target - Figure 9-1

図 9-1 : ペリフェラル IP のブロック図

表 9-1 : ブロック図のコンフ ィギュレーシ ョ ン レジスタの詳細

レジスタ名 制御レジスタ

相対アドレス 0x0000_0000

幅 1 ビッ ト

アクセス  タイプ 読み出し /書き込み

説明 カウンターの開始/停止

フ ィールド名 ビッ ト タイプ リセッ ト値 説明

制御ビッ ト 0 R/W 0x0 1 : カウンターの開始

0 : カウンターの停止
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° チュート リ アル : テンプレートの生成と保存

° チュート リ アル : CIP ウ ィザードで生成されたテンプレート フ  ァ イルの変更

注記 : 『EDK コンセプ ト、 ツールおよびテクニッ ク』 (UG683) へのリ ンクは、 付録 A 「その他のリ ソース」 に記
載されています。

9.3 PS の GP マスター ポート を用いてペリフェラル 
IP を統合する
Zynq のプロセッシング ロジッ ク  (PL) で、 ペリ フェラル IP をスレーブと してインスタンシエート して
ZC702 ボード用システムを作成し、 これをプロセッシング システム (PS) の汎用 (GP) マスター ポート を介して PS
プロセッサと接続します。 図 9-2 にシステムのブロ ッ ク図を示します。

このシステムにおける接続は次のとおりです。

• ペリ フェラル IP は PS 汎用マスター ポート  0 (M_AXI_GP0) に接続されています。 PS CPU はこの接続を使用し、
ペリ フェラル IP レジスタをコンフ ィギュレーシ ョ ンします。

• ペリ フェラル IP の 4 つの出力ポートはオンボード  LED (DS15、DS16、DS17、および DS18) に接続されています。

このシステムでは、 アプ リ ケーシ ョ ン コードを実行する と、 LED の点滅開始または停止の選択を求める メ ッセージ
がシ リアル ターミナルに表示されます。

• 開始を選択する と、 4 つの LED すべてが点滅を開始します。

• 停止を選択する と、 4 つの LED すべてが点滅を停止して以前の状態に保持されます。

X-Ref Target - Figure 9-2

図 9-2 : ブロック図

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_4/edk_ctt.pdf#G7.468811
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_4/edk_ctt.pdf#G7.478670
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9.3.1 チュート リアル : PS の GP マスター ポート を用いて
ペリフェラル IP を統合する

1. PlanAhead™ ツールの [Sources] ペインで、 [system_i-system(system.xmp)] をダブルク リ ッ クして XPS を起動します。

2. XPS で [File] → [Open] をク リ ッ ク します。

3. blink という  pcore の MPD ファ イルを <project dir>\project_1\
project_1.srcs\sources_1\edk\system\pcores\blink_v1_00_a\data ディ レク ト リから開きます。

4. コ メン ト  ##Ports の下に次の行を追加します。

PORT LEDs = "", DIR = O, VEC = [3:0]

5. ファ イルを保存します。

6. XPS で [Project] → [Rescan User Repositories] をク リ ッ ク し、blink という  pcore の変更箇所を XPS に認識させます。

7. IP カタログで [Project Local PCores] の下にある  [USER] を展開し、 [BLINK] をダブルク リ ッ ク して追加します。

blink 1.00.a IP インスタンスをデザインに追加するかど うかを確認する メ ッセージが表示されます。

8. [Yes] をク リ ッ ク します。

[BLINK Configuration] ウ ィンド ウが開きます。

9. [BLINK Configuration] ウ ィンド ウでは、 デフォルト設定のままにしておいて [OK] をク リ ッ ク します。

「blink IP with version number 1.00.a is instantiated with name blink_0」 と表示されたメ ッセージ ウ ィンド ウが開きま
す。 接続先のプロセッサを決定するよ うに求められます。 こ こでは、 デュアル コア ARM プロセッサを使用して
設計しています。 また、 このメ ッセージは、 XPS でバス  インターフェイスの接続およびアドレスの割り当てが
実行され、 IO ポートが外部に設定されるこ とを示します。

デフォルトで選択されているプロセッサは processing_system7_0 です。 このままこれを使用します。

10. [OK] をク リ ッ ク します。

11. IP およびそれらのポートがリ ス ト されている  [Ports] タブをク リ ッ ク します。 [axi_interconnect_1] および
[blink_0] を展開します。

12. 次の IP の接続を確認します。 これらの中で接続されていないものがあれば、 こ こで接続します。

13. すべての IP を非展開にし、 [processing_system7_0] を展開します。 次のよ うにポートが接続されていない
場合は、 こ こで接続します。

14.  [Addresses] タブをク リ ッ ク し、[Generate Addresses]  をク リ ッ ク してマップされていないデバイスのアドレ
スを生成します。

[blink_0] が [processing_system7_0] アドレス範囲内のアドレスに割り当てられているこ とを確認します。

注記 : エラーの場合は前の手順を再度確認します。

15. processing_system7_0 のアドレス  マップでは、 次を実行します。

a. [blink_0] のベース  アドレスを 0x7C600000 に変更します。

IP ポート 接続

axi_interconnect_1 INTERCONNECT_ACLK processing_system7_0::FCLK_CLK0

INTERCONNECT_ARESETN processing_system7_0::FCLK_RESET0_N

blink_0 LED External Ports::blink_0_LEDs_pin

IP ポート 接続

Processing_system7_0 (BUS_IF) M_AXI_GP0::M_AXI_GPO_ACLK processing_system7_0 ::FCLK_CLK0
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b. [blink_0] の上位アドレスを 0x7C60FFFF に変更します。

16. デザイン ルール チェッ ク  (DRC) を実行します。 コンソールにエラーがないこ とを確認します。

17. XPS を閉じます。

PlanAhead™ デザイン ツール ウ ィンド ウが再度アクティブになり ます。

18. [Design Sources] でエンベデッ ド  ソースをク リ ッ ク してから右ク リ ッ ク し、 [Create Top HDL] をク リ ッ ク します。
PlanAhead ツールによって system_stub.v ファ イルが生成されます。

19. Flow Navigator の [Project Manager] リ ス トで [Add Sources] を選択します。

20. ダイアログ ボッ クスが開くので、 [Add or Create Constraints] をオンにします。

21. [Next] をク リ ッ ク します。

22. [Create File] をク リ ッ ク します。

23. [Create Constraints File] ダイアログ ボッ クスが開くので、 ファ イル名に 「system」 と入力して [OK] をク リ ッ ク し
ます。

24. [Finish] をク リ ッ ク します。

25. [Sources] ウ ィンド ウで [Constraints] フォルダーを展開します。空の system.ucf ファ イルが constrs_1 に追加
されているこ と確認します。

26. UCF ファ イルで次のテキス ト を入力します。

# Connect to LED DS17
NET blink_0_LEDs_pin<0> IOSTANDARD=LVCMOS18 | LOC=V7;
# Connect to LED DS16
NET blink_0_LEDs_pin<1> IOSTANDARD=LVCMOS18 | LOC=W10;
# Connect to LED DS15
NET blink_0_LEDs_pin<2> IOSTANDARD=LVCMOS18 | LOC=P18;
# Connect to LED DS14
NET blink_0_LEDs_pin<3> IOSTANDARD=LVCMOS18 | LOC=P17;

これによ り、 Blink IP の 4 つの出力ポート とボードの 4 つの LED が接続されます。

27. [Flow Navigator] の [Program and Debug] リ ス トで [Generate Bitstream] を選択します。

X-Ref Target - Figure 9-3

図 9-3 : [Sources] ビュー
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注記 : 表示される警告メ ッセージは、 無視しても問題あ り ません。

28. ビッ ト ス ト リームの生成が完了したら、第 2 章 「Zynq プロセッシング システムを使用する  エンベデッ ド  システ
ム デザイン」 の説明に従ってハード ウェアをエクスポート して SDK を起動します。

9.4 ペリフェラル IP 向け Linux ベースのデバイス 
ド ライバーの開発

Linux のモジュールは必要に応じてカーネルにロード /アンロードできるコードです。 このよ うに追加したコードは
LKM (Loadable Kernel Module) と呼ばれます。 LKM はシステムを リブートせずにカーネルの機能を拡張します。 これ
らのモジュールがなければ、 モノ リ シッ ク  カーネルを構築してカーネル イ メージに直接新しい機能を追加する必要
があ り ます。 したがって、 カーネルが大き くなるだけでなく、 新しい機能が必要となるたびにカーネルの再構築と リ
ブートが求められる という欠点もあ り ます。

LKM は一般に次のいずれかを指します。

• デバイス  ド ラ イバー : ハードウェア向けに設計されています。カーネルは、デバイス  ド ラ イバーを使用するこ と
でハード ウェアがどのよ うに機能するかを詳細に把握していなくてもそのハード ウェアと通信できます。

• ファ イルシステム ド ラ イバー : ファ イル システム ド ラ イバーはファイル システムの内容をファイルおよびディ
レク ト リ と して解釈します。

• システム コール : ユーザー空間プログラムはシステム コールを使用してカーネルにサービスを要求します。

Linux では、各ハード ウェアはデバイス  ファ イルと して指定されているファイルで表され、デバイス  ファ イルはハー
ドウェアとの通信手段を提供します。 また、 ほとんどのハード ウェア デバイスが出力および入力に使用されるため、
デバイス  ファ イルはハード ウェアとのデータ送受信を担う入力/出力制御 (ioctl) を提供します。 各デバイスは、 次の
よ うな独自の ioctl コマンドを持つこ とができます。

• read ioctl : プロセスからカーネルへ情報を送信する

• write ioctl : プロセスへ情報を返す

• read ioctl および write ioctl の両方

• read ioctl も  write ioctl もなし

LKM の詳細は、 http://tldp.org/LDP/lkmpg/2.6/html/index.html を参照してください。

こ こでは、 ペリ フェラル IP のデバイス  ド ラ イバーを、 実行中のカーネルに動的にロード可能な LKM と して開発し
ます。 ペリ フェラル IP の LKM は、 ベース  カーネル イ メージを生成する同じカーネル構築プロセスの一部と して構
築する必要があ り ます。

注記 : デバイス  ド ラ イバーのコンパイルが必要ない場合は、 このセクシ ョ ンのチュート リ アルを省略して 「9.5 実行
中のカーネルへのモジュールのロード  およびアプリ ケーシ ョ ンの実行」 へ進んでください。 セクシ ョ ン 9.5 では、 ペ
リ フェラル IP 用にすでにコンパイルされたカーネル オブジェク ト  イ メージ (blink.ko) を使用します。 これは、 こ
のガイ ドで提供されている  ug873-design-files.zip から入手できます。この ZIP ファ イルへのリ ンクは、付録 A
「その他のリ ソース」 に記載されています。

カーネルのコンパイルおよびデバイス  ド ラ イバーの開発には、 Linux ワークステーシ ョ ンを使用してください。

デバイス  ド ラ イバーの開発を開始する前に、 次を実行しておく必要があ り ます。

1. CodeSourcery ツールチェーン パスをユーザーの Linux ワークステーシ ョ ンで設定します。

2. カーネル ソース  コードをダウンロード し、 それをコンパイルします。 ダウンロードおよびコンパイルは、
http://wiki.xilinx.com/zynq-linux に記載されいている手順を参照してください。

http://tldp.org/LDP/lkmpg/2.6/html/index.html
http://wiki.xilinx.com/zynq-linux
http://wiki.xilinx.com/zynq-linux
http://japan.xilinx.com


Zynq AP SoC CTT japan.xilinx.com 77
UG873 (v14.6) 2013 年 6 月 19 日

実行中のカーネルへのモジュールのロード  およびアプリケーシ ョ ンの実行

9.4.1 チュート リアル : デバイス ド ライバーを開発する  
こ こでは Linux ワーク ステーシ ョ ンを使用します。 デバイ ス  ド ラ イバー ソ フ ト ウ ェアおよび make フ ァ イルは、
ug873-design-files.zip ファ イルの LKM フォルダーにあ り ます。 この ZIP ファ イルへのリ ンクは、付録 A 「そ
の他のリ ソース」 に記載されています。

1. LKM フォルダーをユーザーの Linux ワークステーシ ョ ンにコピーします。

2. LKM フォルダー内で make ファ イルを開き、 KER_DIR パラ メーターにダウンロード した Linux カーネル ディ レ
ク ト リのパスを指定します。

注記 : モジュールのコンパイルの詳細は、 linux/Documentation/kbuild/modules.txt ファ イルを参照し
てください。

3. LKM フォルダー内で、 コマンド  プロンプ トで 「make clean」 と入力して既存のオブジェク ト  ファ イルをク リー
ン アウ ト します。

4. コマンド  プロンプ トで 「make」 と入力してデバイス  ド ラ イバーを構築します。 コンパイル メ ッセージを確認し
ます。

完了後、 デバイス  ド ラ イバーによって blink.ko カーネル オブジェク トが生成されます。 この後、 実行中のカーネ
ルへ *.ko をロード して ください。

9.5 実行中のカーネルへのモジュールのロード
およびアプリケーシ ョ ンの実行 
このセクシ ョ ンでは、 Zynq ボードで Linux をブート し、 ペリ フェラル IP を LKM と してこのボードへロード します。
システム用のアプリ ケーシ ョ ンを開発し、 これをハード ウェアで実行します。

9.5.1 モジュールをカーネル メモリへロードする

LKM を挿入する基本的なプログラムは、 insmod です。 insmod は、 init_module システム コールを呼び出して
LKM をカーネル メモ リへロード します。 init_module システム コールは、 LKM をロード した直後に LKM の初期
化ルーチンを開始します。 この初期化ルーチンの一環と して、 insmod は init_module へサブルーチンのアドレス
を渡します。

ペリ フェラル IP のデバイス  ド ラ イバーでは、 init_module はサブルーチンを登録するカーネル関数を呼び出すよ
うに設定されています。これは、カーネルの register_chrdev サブルーチンを呼び出し、駆動対象のデバイスのメジャー
番号とマイナー番号、 および独自のオープンなルーチンのアドレスを引数間で渡します。
register_chrdev サブルーチンはカーネルのベース  テーブルの中で、 カーネルが特定デバイスを開く必要がある
と きにユーザーの LKM でオープンなルーチンを呼び出すよ うに指定します。

9.5.2 アプリケーシ ョ ン  ソフ トウェア

アプリ ケーシ ョ ン ソフ ト ウェアの main() 関数は、実行のエン ト リ  ポイン トです。 この関数はペリ フェラル IP のデ
バイス  ファ イルを開いた後、 シ リ アル ターミナルでのユーザーの選択を待機します。 

開始を選択する と、 4 つの LED すべてが点滅を開始します。 停止を選択する と、 4 つの LED すべてが点滅を停止し
て以前の状態に保持されます。
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9.5.3  チュート リアル : モジュールをカーネルへロード
し、 アプリケーシ ョ ンを実行する

ターゲッ ト  ボートで Linux をブートする

「5.2 Zynq ボード上で Linux をブートする」の説明に従って、Zynq ZC702 ターゲッ ト  ボードで Linux をブート します。

モジュールをロード し、 アプリケーシ ョ ンを実行する

注記 : このセクシ ョ ンでは、 Windows マシンにインス トールされている  SDK ツールを使用します。

1. SDK が開かれていない場合は、 こ こで開きます。

2. SDK の場合、 TCF (Target Communication Frame) エージェン ト をホス ト  マシンで実行します。 [Xilinx Tool] →
[Launch Hardware Server] をク リ ッ ク します。

3. SDK で [File] → [New] → [Xilinx C Project] をク リ ッ ク します。

New Project ウ ィザードが開きます。

4. 次の表の情報に基づいて、 ウ ィザード画面で選択操作を行います。

5. [Finish] をク リ ッ ク します。

New Project ウ ィザードが閉じ、 SDK によって linux_blinkled_app プロジェク トが [Project Explorer] の下に作成さ
れます。

6. [Project Explorer] タブで [linux_blinkled_app] プロジェク ト を展開し、[src] ディ レク ト リ を右ク リ ッ ク して [Import]
をク リ ッ ク します。

[Import] ダイアログ ボッ クスを開きます。

7. [Import] ダイアログ ボッ クスで [General] を展開し、 [File System] をク リ ッ ク します。

8. [Next] をク リ ッ ク します。

9. linux_blinkled_app.c および blink.h ファ イルを追加します。

注記 : システム用のアプリ ケーシ ョ ン ソフ ト ウェア ファ イル名は linux_blinkled_app.c で、ヘッダー ファ
イル名は blink.h です。 これらのファ イルは、 このガイ ドで提供されている  ug873-design-files.zip の
LKM フォルダーから入手できます。 この ZIP ファ イルへのリ ンクは、付録 A 「その他のリ ソース」 に記載されて
います。

10. [Finish] をク リ ッ ク します。

SDK は自動的にアプリ ケーシ ョ ンを構築し、 linux_blinkled_app.elf ファ イルを生成します。 コンソール
ウ ィンド ウでこの動作のステータスを確認します。

ウィザード画面 システム プロパティ 使用する設定コマンド

Application Project

Project Name linux_blinkled_app

Use Default Location このオプシ ョ ンをオンにする。

Hardware Platform system_hw_platform

Processor PS7_cortexa9_0

OS Platform Linux

Language C

Templates Available Templates Linux の空のアプリ ケーシ ョ ン
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11. ボードを接続します。

12. PL ファブ リ ッ クのビッ ト ス ト リームがすでにあるため、 これをダウンロード します。 [Xilinx Tools] → [Program
FPGA] をク リ ッ ク します。 [Program FPGA] ダイアログ ボッ クスが開きます。PlanAhead からエクスポート された
ビッ ト ス ト リームが表示されます。

13. [Program] をク リ ッ ク し、 ビッ ト ス ト リームをダウンロード して PL ファブ リ ッ クをプログラムします。

14. 「9.4.1 チュート リ アル : デバイス  ド ラ イバーを開発する」 で作成した blink.ko を、 Linux ワークステーシ ョ ン
から  Windows マシンにコピーします。

注記 : このセクシ ョ ンの後半では、 blink.ko およびアプ リ ケーシ ョ ン ELF ファ イルをボード  メモ リへコピー
して実行するために、 Windows マシンとボード間の接続を確立します。

注記 : Zync PS は一時停止状態にあ り、 Zync Linux ターミナルに応答はあ り ません。 Zync の再開については、 ア
ンサー 55150 を参照してください。

15. [Windows] → [Open Perspective] → [Other] をク リ ッ ク します。

[Open Perspective] ウ ィンド ウが表示されます。

16. [Remote System Explorer] をク リ ッ ク して [OK] をク リ ッ ク します。

SDK で Remote Systems Perspective エクスプローラーが開きます。

17. Remote Systems Perspective では、 次を実行してください。

a. 右ク リ ッ ク し、 [New] → [Connection] をク リ ッ ク します。

New Connection ウ ィザードが開きます。

b. [SSH Only] タブをク リ ッ ク して [Next] をク リ ッ ク します。

c. [Host Name] タブでターゲッ ト  ボード  IP を入力します。

注記 : ターゲッ ト  IP を確認するには、 シ リ アル ターミナルの zynq> プロンプ トで 「ifconfig eth0」 と入力し
ます。 ボードに割り当てられているターゲッ ト  IP が表示されます。

d. 接続名を 「blink」 と し、 詳細を入力します。

e. [Finish] をク リ ッ ク して接続を作成します。

f. [blink] → [sftp Files] → [Root] を展開します。 Enter Password ウ ィザードが開きます。

g. ユーザー ID およびパスワード  (root/root) を入力し、[Save ID] および [Save Password] をオンにします。

h. [OK] をク リ ッ ク します。

Windows ホス ト  マシン と ターゲッ ト  ボード間の接続がすでに確立されているため、 ウ ィ ン ド ウにルー ト
ディ レク ト リの内容が表示されます。

i. パス名の 「/」 で右ク リ ッ ク し、 新しいディ レク ト リ を 「Apps」 とい う名前で作成します。

j. Remote Systems Perspective エクスプローラーを使用し、 linux_blinkled_app.elf ファ イルを
<project-dir>/project_1/project_1.sdk/SDK/SDK_Export/

linux_blinkleds_apps/Debug フォルダーからコピーして blink の接続の下にある  /Apps ディ レク ト リ
に貼り付けます。

k. Linux ワークステーシ ョ ンから  Windows マシンに既に移動してある  blink.ko ファ イルをコピーし、 blink
の接続の下にある  /Apps フォルダーに貼り付けます。

18. シ リアル ターミナルでは、 zynq> プロンプ トで 「cd Apps」 と入力し、 Apps ディレク ト リ を開きます。

19. zynq> プロンプ トで 「insmod blink.ko」 と入力し、 モジュールをカーネル メモ リに挿入します。

注記 : 「Registration is a success」 とい う メ ッセージが、モジュールに割り当てられている メジャー番号と共に表示
されます。このメ ッセージによって、モジュールがカーネル メモ リ内に正し く挿入されているこ とがわかり ます。

こ こからは、 これを使用するためのデバイス  ファ イルを作成します。 シ リ アル ターミナルのメ ッセージを確認
します。 表示されている メ ッセージは、 引数を持つ mknod コマンドに関連するものです。

http://xkb/pages/55150.aspx
http://xkb/pages/55150.aspx
http://japan.xilinx.com
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実行中のカーネルへのモジュールのロード  およびアプリケーシ ョ ンの実行

20. zynq> プロンプ トで前の手順から表示されている  mknod コマンド  メ ッセージを表示どおりに入力します。

これによ り、 mknod コマンド  メ ッセージに表示されていた名前およびメジャー番号のデバイス  ファ イルが作成
されます。

21. zynq> プロンプ トで、「chmod 777 Linux_blinkled_app.elf」と入力して linux_blinkled_app.elf ファ イル モー
ドを実行ファイル モードに変更します。

22. zynq> プロンプ トで、 「./Linux_blinkled_app.elf」 と入力してアプリ ケーシ ョ ンを実行します。

23. シ リアル ターミナルの手順に従ってアプリ ケーシ ョ ンを実行します。

24. Linux アプリ ケーシ ョ ンのデバッグ終了後、 SDK を閉じます。

http://japan.xilinx.com
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付録 A

その他のリソース

A.1 このガイドのリソース

• この資料に関連する  ZIP ファ イルには、 第 5 章のチュート リ アルのデザイン ファ イルが含まれます。
ug873-design-files.zip は次のサイ トから入手できます。
http://japan.xilinx.com/cgi-bin/docs/ndoc?v=zynq-7000;t=user+guide

• 『EDK コンセプ ト、 ツール、 テクニッ ク  ガイ ド』、 第 6 章 「独自の IP を作成する」
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_6/edk_ctt.pdf

• 『The Effect and Technique of System Coherence in ARM Multicore Technology』、 著者 : John Goodacre (ARM Processor
Division、 Senior Program Manager) (www.mpsoc-forum.org/previous/2008/slides/8-6%20Goodacre.pdf)

• 『ARM Cortex-A9 MPCore Technical Reference Manual』、 セクシ ョ ン 2.4 「Accelerator Coherency Port」
(http://infocenter.arm.com/help/index.jsp?topic=/com.arm.doc.ddi0407e/CACGGBCF.html)

• 「iMPACT での Zynq-7000 All Programmable SoC の操作」
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_4/pim_r_zynq_ops_in_impact.htm)

A.2 ト レーニング演習

このガイ ドのチュート リ アルに関連する ト レーニング演習は次のサイ トで提供されています。
http://japan.xilinx.com/training/embedded/embedded-design-tutorials.htm

A.3 ザイリンクス リソース 
• ISE Design Suite 14 : 『 リ リース  ノート、 インス トール、 ライセンス  ガイ ド』 (UG631) :  

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_6/irn.pdf

• ザイ リ ンクス®資料 : http://japan.xilinx.com/support/documentation

• ザイ リ ンクス用語集 : http://japan.xilinx.com/company/terms.htm 

• ザイ リ ンクス  サポート  : http://japan.xilinx.com/support/

http://japan.xilinx.com/cgi-bin/docs/ndoc?v=zynq-7000;t=user+guide
http://japan.xilinx.com/cgi-bin/docs/rdoc?l=en;v=14.6;d=edk_ctt.pdf
www.mpsoc-forum.org/previous/2008/slides/8-6%20Goodacre.pdf
http://infocenter.arm.com/help/index.jsp?topic=/com.arm.doc.ddi0407e/CACGGBCF.html
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_4/pim_r_zynq_ops_in_impact.htm
japan.xilinx.com/training/embedded/embedded-design-tutorials.htm
http://japan.xilinx.com/cgi-bin/docs/rdoc?v=14.6;t=release+notes
http://japan.xilinx.com/support/documentation
http://japan.xilinx.com/cgi-bin/docs/ndoc?t=glossary
http://japan.xilinx.com/support/
http://japan.xilinx.com
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EDK の資料

A.4 EDK の資料

EDK に関する一連の資料は次のサイ トから入手できます。 
http://japan.xilinx.com/support/documentation/dt_edk_edk14-6.htm

• 『EDK コンセプ ト、 ツール、 テクニッ ク』 (UG683) : 
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_6/edk_ctt.pdf

• 『エンベデッ ド  システム ツール リ ファレンス  マニュアル』 (UG111) :
http://japan.xilinx.com/support/documentation/xilinx14_6/est_rm.pdf

• 『MicroBlaze™ プロセッサ リ ファレンス  ガイ ド』  (UG081) : 
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_6/mb_ref_guide.pdf

• 『プラ ッ ト フォーム仕様フォーマッ トの リ ファレンス  マニュアル』 (UG642) :
http://japan.xilinx.com/support/documentation/xilinx14_6/psf_rm.pdf

• 『Zynq-7000 AP SoC ソフ ト ウェア開発者向けガイ ド』 (UG821) :
http://japan.xilinx.com/support/documentation/user_guides/j_ug821-zynq-7000-swdev.pdf

• 『Zynq-7000 AP SoC テクニカル リ ファレンス  マニュアル』 (UG585) : 
http://japan.xilinx.com/cgi-bin/docs/ndoc?v=zynq-7000;t=user+guide

• Zynq™-7000 AP SoC 関連の資料一覧 : 
http://japan.xilinx.com/cgi-bin/docs/ndoc?v=zynq-7000;t=user+guide

A.5 EDK 関連のその他のリソース

• Xilinx Platform Studio および EDK のウェブサイ ト  :
http://japan.xilinx.com/ise/embedded_design_prod/platform_studio.htm

• Xilinx Platform Studio および EDK の資料一覧 :
http://japan.xilinx.com/ise/embedded/edk_docs.htm

• ザイ リ ンクス  XPS/EDK がサポートする  IP のウェブサイ ト  :
http://japan.xilinx.com/ise/embedded/edk_ip.htm

• ザイ リ ンクス  チュート リ アルのウェブサイ ト  :
http://japan.xilinx.com/support/documentation/dt_edk_edk14-6_tutorials.htm

• ザイ リ ンクス  データシートの一覧 :
http://japan.xilinx.com/cgi-bin/docs/ndoc?t=data+sheet

• ザイ リ ンクス  ト ラブルシュート  :
http://japan.xilinx.com/support/troubleshoot/psolvers.htm

• ザイ リ ンクス  ISE® Design Suite の資料一覧 : 
http://japan.xilinx.com/support/software_manuals.htm

• GNU の資料一覧 :
http://www.gnu.org/manual

http://japan.xilinx.com
http://japan.xilinx.com/support/index.html/content/xilinx/ja/supportNav/design_tools/embedded_development_kit__edk.html
http://japan.xilinx.com/ise/embedded_design_prod/platform_studio.htm
http://japan.xilinx.com/cgi-bin/docs/rdoc?l=en;v=14.6;d=edk_ctt.pdf
http://japan.xilinx.com/cgi-bin/docs/rdoc?l=en;v=14.6;d=est_rm.pdf
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx14_6/mb_ref_guide.pdf
http://japan.xilinx.com/cgi-bin/docs/rdoc?l=en;v=14.6;d=psf_rm.pdf
http://japan.xilinx.com/support/documentation/user_guides/ug821-zynq-7000-swdev.pdf
http://japan.xilinx.com/cgi-bin/docs/ndoc?v=zynq-7000;t=user+guide
http://japan.xilinx.com/cgi-bin/docs/ndoc?v=zynq-7000;t=user+guide
http://japan.xilinx.com/support/index.html/content/xilinx/ja/supportNav/design_tools/embedded_development_kit__edk.html
http://japan.xilinx.com/ise/embedded/edk_ip.htm
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=en&ver=14.6&topic=edk+tutorials
http://japan.xilinx.com/cgi-bin/docs/ndoc?t=data+sheet
http://japan.xilinx.com/support/troubleshoot/psolvers.htm
http://japan.xilinx.com/support/index.html/content/xilinx/ja/supportNav/design_tools/ise_design_suite.html
http://www.gnu.org/manual
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